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© 2017 AstroNova, Inc. All Rights Reserved
This manual is copyrighted with all rights reserved. No part of this manual may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any 
language in any form by any means without written permission of QuickLabel.

Trademarks
Kiaro!® and Custom QuickLabel Omni® are registered trademarks of AstroNova, Inc.

Adobe®, Photoshop®, and Illustrator® are registered trademarks of Adobe Systems, 
Inc.

Corel® is a registered trademark of Corel Corporation.

Microsoft® Windows® XP, Windows® Vista®, and Windows® 7 are registered 
trademarks of Microsoft Corporation.

Kiaro! Limited Warranty
QuickLabel, An AstroNova Division, warrants all components of this product, except 
wear parts and consumables, against defects in materials or workmanship for a period 
of one (1) year from the date of original purchase. Wear parts include the transport unit, 
purge unit, blade cleaner, maintenance cartridge, cutter blades and the like. 
Consumables include ink cartridges and labels, which are covered under a separate 
warranty. If the customer discovers a defect, this defect must be reported promptly to 
QuickLabel. QuickLabel will, at its option, repair the printer or repair or replace its 
defective component(s) at no additional charge under our QuickSwap™ Parts Service. 
Repair parts and replacement parts will be furnished on an exchange basis and will be 
either reconditioned or new. The customer is responsible for freight to return the printer 
or component to our factory. We will ship the repaired or replaced printer or component 
back to you via standard ground freight service. All replaced parts become the property 
of QuickLabel. Travel, freight and other expenses related to warranty repairs are not 
covered.

In the first year of product ownership, you may be covered by a separate Customer 
Support Agreement purchased from or issued by QuickLabel or an authorized 
QuickLabel dealer. In such a case, you would be entitled to an on-site installation 
and/or training visit. Otherwise, Customer Support Agreements and renewals are 
available for purchase and provide on-site support and/or QuickSwap Parts Service.

This warranty is void if the product has been damaged by accident, abuse, neglect or 
misapplication or by the use of incompatible consumables or parts, or if the product has 
been improperly installed, or if the product has been modified without the express 
written permission of QuickLabel. QuickLabel is not responsible for products lost or 
damaged in transit.

QuickLabel makes no warranty, either express or implied, with respect to this product's 
merchantability or fitness for a particular purpose. In no event shall QuickLabel be held 
liable for any direct, indirect, special, incidental, or consequential damages, whether 
based on a contract, tort, or any other legal theory and whether advised of the 
possibility of such damages.



Ink Limited Warranty
This warranty covers QuickLabel Kiaro! ink cartridge sold by QuickLabel.

Each Kiaro! ink cartridge is warranted to be free from defects in materials and 
workmanship for up to 24 months from the date of manufacture if in original unopened 
packaging, or up to 6 months after installation, whichever occurs first. This warranty 
applies only to the ink cartridges as used in the QuickLabel Kiaro! printing system.

If the customer suspects a defect in a Kiaro! ink cartridge, the customer must notify 
QuickLabel within the warranty period. Upon return of the ink cartridge to the 
QuickLabel factory and QuickLabel's verification of the defect, QuickLabel will, at its 
option, either:

1. Replace the defective ink cartridge; or,

2. If the customer has used the ink, pro-rate the price of a new ink based upon the 
estimated life remaining for the ink, as reported by the Kiaro! system. The Kiaro! 
provides the estimated life remaining, and QuickLabel may obtain this information from 
the system remotely or request the customer to furnish this information.

This warranty does not cover Kiaro! ink cartridges that have been emptied, refilled, 
remanufactured, modified, refurbished, misused, or tampered with, or that have 
expired, or when used to print on label or tag media that is not compatible with the 
Kiaro!

This warranty is void if the Kiaro! ink cartridge has been damaged by accident, abuse, 
neglect or misapplication, if the product has been improperly installed or maintained, if 
the product has been used outside of its environmental specifications, or if the product 
has been modified without the express written permission of QuickLabel.

QuickLabel makes no warranty, either express or implied, with respect to this product's 
merchantability or fitness for a particular purpose. In no event shall QuickLabel be held 
liable for any direct, indirect, special, incidental, or consequential damages, whether 
based on a contract, tort, or any other legal theory and whether advised of the 
possibility of such damages.

Printhead Limited Warranty
QuickLabel warrants the printhead from the date of purchase for a period of 90 days or 
for 1 million inches of printing, whichever comes first, contingent upon the use of 
QuickLabel ink and labels. The Kiaro! printhead is calibrated for use with QuickLabel 
ink and labels and performs optimally only when used with these materials. This 
specific printhead warranty does not apply to printheads damaged by accident, abuse, 
neglect, misapplication or the like. This warranty is void if the product has been 
damaged by accident, abuse, neglect or misapplication, or if the product has been 
improperly installed, or if the product has been modified without the express written 
permission of QuickLabel.

ICC Profile
ICC Profile Powered by X-Rite Incorporated



 

Obtaining Service
To obtain warranted service, please contact QuickLabel Technical Support through 
one of the Factory Sales and Service Centers.

Contact Information for Factory Sales and Service
QuickLabel USA and World Headquarters 
600 East Greenwich Avenue 
West Warwick, RI 02893 USA 
Toll Free: (877) 757-7978 
Toll-Free Sales: (877) 757-7978 
Toll Free Technical Support: (877) 757-7310 
Tel: (401) 828-4000 
Fax: (401) 822-2430 
Web Site: www.QuickLabel.com 
Sales E-mail: info@QuickLabel.com 
Technical Support E-mail: support@QuickLabel.com 

QuickLabel Canada 
#111 - 3555 Isabelle, Borssard, QC J4Y 2R2 Canada 
Tel: (800) 565-2216 
Fax: (450) 619-9976 
Web Site: www.QuickLabel.ca 
Sales E-mail: info@QuickLabel.ca 
Technical Support E-mail: support@QuickLabel.ca 

QuickLabel Deutschland 
Senefelderstraße 1/ T6 D-63110 Rodgau 
Tel. +49 (0) 6106-28368-20 
Fax: +49 (0) 6106-771121 
Web Site: www.QuickLabel.de 
Sales E-mail: info@QuickLabel.de 
Technical Support E-mail: support@QuickLabel.de 

QuickLabel France 
Parc Euclide 
ZA la Clef de St Pierre 
10A Rue Blaise Pascal 
78990 ELANCOURT 
Tel: 33 1 34 82 09 00 
Fax: 33 1 34 82 05 71 
Web Site: www.QuickLabel.fr 
Sales E-mail: info@QuickLabel.fr 
Technical Support E-mail:support@QuickLabel.fr 

QuickLabel United Kingdom 
11 Whittle Parkway 
Slough, Berkshire SL1 6DQ 
Tel: 01628 668836 
Fax: 01628 664994 
Web Site: www.QuickLabel.co.uk 
Sales E-mail: info@QuickLabel.co.uk 
Technical Support E-mail:support@QuickLabel.co.uk 



Ownership Information
Congratulations and thank you for your business. Your purchase of a QuickLabel digital 
label printer is an investment in production flexibility and packaging efficiency. Please 
record the model number and serial number of your product.

FCC Part 15 Compliance
NOTE: This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation.

If this equipment does cause interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by the 
party responsible for compliance could void the user's authority to operate the 
equipment.

Canadian Compliance Statement
This Class B digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur 
le matériel brouilleur du Canada.

RoHS2 Compliance
The Kiaro! Label Printer does not contain the substances specified within ANNEX II of 
"Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011 
on the restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS)", that is, lead, mercury, cadmium, hexavalent chromium, 
polybrominated biphenyls (PBB) and polybrominated diphenyl ethers (PBDE) 
exceeding their specified maximum concentration values tolerated by weight in 
homogeneous materials, except for the exemptions set in ANNEX Ill of the Directive 
and its amendments.

This information is offered in good faith to the best of our knowledge, but is subject to 
revision as new information becomes available.



 

WEEE Directive

European Union (and EEA) only.

These symbols indicate that this product is not to be disposed of with your household 
waste, according to the WEEE Directive (2002/96/EC), the Battery Directive 
(2006/66/EC) and/or your national laws implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with 
the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, 
Pb = Lead) is present in this battery or accumulator at a concentration above an 
applicable threshold specified in the Battery Directive.

This product should be handed over to a designated collection point, e.g., on an 
authorized one-for-one basis when you buy a new similar product or to an authorized 
collection site for recycling waste electrical and electronic equipment (EEE) and 
batteries and accumulators. Improper handling of this type of waste could have a 
possible impact on the environment and human health due to potentially hazardous 
substances that are generally associated with EEE.

Your cooperation in the correct disposal of this product will contribute to the effective 
usage of natural resources.

For more information about the recycling of this product, please contact your local city 
office, waste authority, approved scheme or your household waste disposal service.

(EEA: Norway, Iceland and Liechtenstein)

WEEE Compliance - India only
This product is not to be disposed of with your household waste, according to the 
e-waste (Management and Handling) Rules, 2011. This product should be handed over 
to a designated collection point, e.g., to an authorized collection site for recycling waste 
electrical and electronic equipment (EEE). Improper handling of this type of waste 
could have a possible negative impact on the environment and human health due to 
potentially hazardous substances that are generally associated with EEE. At the same 
time, your cooperation in the correct disposal of this product will contribute to the 
effective usage of natural resources. For more information regarding return and 
recycling of WEEE products, please contact QuickLabel.

Also, this product complies with the "India E-waste Rule 2011" and prohibits use of 
lead, mercury, hexavalent chromium, polybrominated biphenyls or polybrominated 
diphenyl ethers in concentrations exceeding 0.1 % by weight and 0.01 % by weight for 
Cadmium, except for the exemptions set in Schedule ll of the Rule.



Battery - For CA, USA only
Included battery contains Perchlorate Material ---- special handling may apply.

See http://www.dtsc.ca.gov/hazardouswaste/perchlorate for detail.

European Union (and EEA) only
Contains a preservative to control microbial deterioration.

Contains 1,2-benzisothiazol-3(2H)-one.

May produce an allergic reaction.

Contains less than 30% of components with unknown hazards to the aquatic 
environment.

Safety data sheet available on request.



 

Declaration of Conformity
Declaration de Conformité
Ubereinstimmungserklärung
Dichiarazione di Conformità

ID DoC-22834607

Manufacturer’s name and address
Nom et adresse du fabricant
Hersteller
Nome del costruttore

AstroNova, Inc.
600 East Greenwich Avenue
West Warwick, RI 02893 USA

Model No.
Modele No.
Model Nr.
Modello No.

Kiaro!

Description of Products
Description des produits
Produktbeschreibungen
Descrizione dei Prodotti

Color Label Printer

Standards to which conformity is declared
Standards auquel la conformité appartient
Normen für welche Übereinstimmung erklärt wird
Norme per le quali si dichiara la conformità

UL 60950-1 2nd Edition
CAN/CSA-C22.2 No.60950-1-07 2nd Edition
IEC 60950-1(ed.2)
IEC 60950-1(ed.2);am1
IEC 60950-1(ed.2);am2
EN 60950-1:2006 /A11:2009/A1:2010/A12:2011/A2:2013
EN 55032:2012 Class B
EN 61000-3-2:2014 Class A
EN 61000-3-3:2013
EN 55024:2010
EN 50564:2011
(Commission Regulation (EC) No 1275/2008)
FCC Part 15B Class B
ICES-003 Issue 6 Class B

Application of Council Directives
Application des Decisions du Conseil
Anwendbar fur die Richtlinien
Applicazione delle Direttive del Comitato

2011/65/EU
2014/30/EU
2014/35/EU

I, the undersigned, hereby declare that the equipment specified above conforms to the above Directive and Standard.

Je, Soussigné, déclare que l’équipment spécifié ci-dessus est en conformité avec la directive et le standard ci-dessus.

Ich, der unterzeichnende erkläre hiermit, daß das oben beschriebene Gerät den vorgenannten Richtlinien und Normen entspricht.

Il sottoscritto dichiara che l’apparecchio sopra specificato è conforme alle Direttive e Norme sopra specificate.

Steven Holbrook
Quality Assurance Manager
AstroNova, Inc.
CE Label First Affixed Date: 13

Date of issue: 7/1/2016
Place of issue: West Warwick, RI

European Contact: Your local AstroNova, Inc. Sales and Service Office.

FRANCE - Parc Euclide, ZA la Clef de St Pierre, 10A Rue Blaise Pascal 78990 Elancourt 
Tel: (+33) 1 34 82 09 00, Fax: (+33) 1 34 82 05 71

GERMANY - Senefelderstrasse 1/T6, D-63110 Rodgau 
Tel. +49 (0) 6106-28368-20, Fax: +49 (0) 6106-771121

UNITED KINGDOM - 11 Whittle Parkway, Slough, Berkshire, SL1 6DQ 
Tel: +44 (0)1628 668836, Fax: +44 (0)1628 664994



Declaration of Conformity
Declaration de Conformité
Ubereinstimmungserklärung
Dichiarazione di Conformità

ID DoC-22834607-D

Manufacturer’s name and address
Nom et adresse du fabricant
Hersteller
Nome del costruttore

AstroNova, Inc.
600 East Greenwich Avenue
West Warwick, RI 02893 USA

Model No.
Modele No.
Model Nr.
Modello No.

Kiaro! D

Description of Products
Description des produits
Produktbeschreibungen
Descrizione dei Prodotti

Color Label Printer

Standards to which conformity is declared
Standards auquel la conformité appartient
Normen für welche Übereinstimmung erklärt wird
Norme per le quali si dichiara la conformità

UL 60950-1 2nd Edition
CAN/CSA-C22.2 No.60950-1-07 2nd Edition
IEC 60950-1(ed.2)
IEC 60950-1(ed.2);am1
IEC 60950-1(ed.2);am2
EN 60950-1:2006 /A11:2009/A1:2010/A12:2011/A2:2013
EN 55032:2012 Class B
EN 61000-3-2:2014 Class A
EN 61000-3-3:2013
EN 55024:2010
EN 50564:2011
(Commission Regulation (EC) No 1275/2008)
FCC Part 15B Class B
ICES-003 Issue 6 Class B

Application of Council Directives
Application des Decisions du Conseil
Anwendbar fur die Richtlinien
Applicazione delle Direttive del Comitato

2011/65/EU
2014/30/EU
2014/35/EU

I, the undersigned, hereby declare that the equipment specified above conforms to the above Directive and Standard.

Je, Soussigné, déclare que l’équipment spécifié ci-dessus est en conformité avec la directive et le standard ci-dessus.

Ich, der unterzeichnende erkläre hiermit, daß das oben beschriebene Gerät den vorgenannten Richtlinien und Normen entspricht.

Il sottoscritto dichiara che l’apparecchio sopra specificato è conforme alle Direttive e Norme sopra specificate.

Steven Holbrook
Quality Assurance Manager
AstroNova, Inc.
CE Label First Affixed Date: 14

Date of issue: 7/1/2016
Place of issue: West Warwick, RI

European Contact: Your local AstroNova, Inc. Sales and Service Office.

FRANCE - Parc Euclide, ZA la Clef de St Pierre, 10A Rue Blaise Pascal 78990 Elancourt 
Tel: (+33) 1 34 82 09 00, Fax: (+33) 1 34 82 05 71

GERMANY - Senefelderstrasse 1/T6, D-63110 Rodgau 
Tel. +49 (0) 6106-28368-20, Fax: +49 (0) 6106-771121

UNITED KINGDOM - 11 Whittle Parkway, Slough, Berkshire, SL1 6DQ 
Tel: +44 (0)1628 668836, Fax: +44 (0)1628 664994
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1 Quick Start Guide

Before Installing the Printer

Choosing an Installation Location
The installation environment must be as described in this section.

• The printer power cord must be able to connect to an outlet (100V - 240V AC 
+10%/-15%). This outlet must be easily accessible.

• Avoid installing the printer near a faucet, water heater, humidifier, or refrigerator.

• Ensure the environment temperature is within 59 to 86 degrees Fahrenheit (15 to 
30 degrees Celsius).

• Ensure the environment humidity is within 10% to 80% relative humidity.

• Avoid placing the printer in areas exposed to high temperature and humidity, 
extremely low temperature, severe temperature changes, or direct sunlight. 
Especially, avoid placing the printer near fire, outdoors, in distribution warehouses, 
or in refrigerated areas.

• Avoid installing the printer in areas subject to dust.

• The room must be properly ventilated.

• No printer feet should float. The printer must be held level constantly.

• When placing the printer on a desk, table, or other similar surface, it must be sturdy 
and stable enough to support the weight of the printer.
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• The minimum space required for installation and maintenance is shown below.

Installation Precautions
When installing the printer, observe the following precautions.

• Imaging faults can result from dew condensation that occurs when the printer is 
moved from a cold place to a warm place. Leave the unpacked printer as is for at 
least two hours before installing it.

• The printer weighs about 53 pounds (24 kilograms). Two persons are required to 
lift the printer. Two persons standing at the front and back of the printer respectively 
must lift the printer by holding it with their hands under the bottom handles (two at 
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the front, one at the left, and one at the right). Attempting to lift the printer in an 
improper position can result in the printer falling or injury.

System Requirements

• 32-bit or 64-bit Microsoft® Windows® XP, Windows Vista®, Windows 7, or 
Windows 8

• Microsoft .NET Framework 3.5 SP1

• 350 MB free hard drive space

• Internet access

• One available USB 2.0 port for USB installation or network connectivity for network 
installation
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Unpacking the Printer
The printer is secured using packing tape and cushioning materials to protect it against 
vibrations and shock during transportation. Use the following procedure to unpack the 
printer. Keep the packing materials for future transportation.

1 Remove the four grips from the packing carton, and then remove the outer casing.

2 Remove the accessory box, and then remove the upper pads.
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3 Unwrap the plastic bag from top to bottom.

4 Holding the handles at the bottom of the printer, lift the printer to take it out from the 
package base. Lift from the illustrated points. Do not hold the front side of the 
printer.

Note: The printer weighs about 53 pounds (24 kilograms). Two persons are 
required to lift the printer. Two persons standing at the front and back of the printer 
respectively must lift the printer by holding it with their hands under the bottom 
handles (two at the front, one at the left, and one at the right). Attempting to lift the 
printer in an improper position can result in the printer falling or injury.

5 Place the printer on a horizontal table. Then remove all pieces of packing tape and 
cushioning materials visible on the exterior of the printer.
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6 Open the roll cover.

7 Remove all pieces of tape securing the roll holder.

8 Push down the upper unit release lever, and then open the upper unit.

9 Remove all pieces of tape inside the printer.
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10 If necessary based on your printer model, remove the protective sheet located over 
the transport unit.

• If you are unpacking the standard Kiaro! printer, turn the pinch roller release 
lever, and then remove the protective sheet.

• If you are unpacking the Kiaro! D printer, leave the protective sheet over the 
transport area. This sheet will be removed after initial ink filling.

Checking the Included Parts
Check to make sure the following items are included with the printer.

• Printhead unit
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• Starter ink tanks (one for each color)

• AC power cables (North American and European)

• USB cable

• Scraper (Kiaro! D only)

Caution: Several power cables come with printer. Use the appropriate power cord for 
the power supply used at the installation site.

Installing the Printer

Installing the Printhead
Use the following instructions to install the printhead.

Caution: The printhead is a sensitive electronic component. Use extreme caution 
when installing it. Follow the provided instructions carefully to prevent damage to the 
printhead.

1 Remove the two thumbscrews to remove the main maintenance cover from the 
upper unit.
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2 Close the upper unit.

3 Remove the print module cover. Then open the upper printhead release lever and 
lower printhead release lever.
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Remove the blade cleaner.

4 Remove the printhead from the package.

Caution: Do not touch the printhead face. An ink injection problem can occur. 
Hold the printhead only by the end tab.
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5 Remove the cover protecting the terminals of the printhead PC boards. Remove 
the protective guides from the ends of the printhead.

6 Remove the caps from the printhead ink supply ports.

Note: The serial number label on a Kiaro! printhead is white. The label is yellow 
on a Kiaro! D printhead.

7 Remove the printhead from the head protector.

8 If you are using the Kiaro! D printer, peel the shipping film from the scraper and 
then install the scraper on the printhead.
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Note: This step applies only to the Kiaro! D. The serial number label is yellow on 
the Kiaro! D printhead. If you are using the standard Kiaro!, skip this step.

Handle the scraper with care, and do not touch the blue area along the bottom of 
the scraper.

9 Mount the printhead in the printer. Ensure the metal alignment pins on the 
printhead insert into the corresponding alignment slots in the printer. Push the 
printhead in until it stops moving.

If printhead is insufficiently inserted, the lower printhead release lever cannot be 
closed. To confirm printhead is in the correct position, see if the end of printhead 
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grip and the edge of the inner metal plate are in the same plane as shown in the 
figure.

10 Mount the blade cleaner in the printer. The blade cleaner (B) rests on the alignment 
slots used by the printhead (A).

Note: The Kiaro! and Kiaro! D blade cleaners differ slightly in appearance, but they 
are installed in the same manner.

11 Close the lower printhead release lever and upper printhead release lever.
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12 Check that numbers (1), (2), and (3) indicated on Print Module are visible.

If any numbers (1), (2), or (3) are invisible, the printhead release lever (1, 2) has 
not been closed or the blade cleaner (3) has not been mounted. Review work 
procedure.

13 Attach the included print module cover to the print module.
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14 Push down the upper unit release lever and then open the upper unit.

15 Install the main maintenance cover on the upper unit with the two thumbscrews.

16 Close the upper unit and then close the roll cover.
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Loading Ink Tanks
1 Open the ink tank door.

2 Open the ink tank lever for each color while pushing it downward.

3 Take out the starter ink tanks from the package. Then remove the packing 
materials.

Do not touch the ink outlet and terminal to prevent soiling of the surrounding work 
area, damage to the ink tank, and poor printing. Never drop or apply excessive 
force to an ink tank.
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4 If you are using the Kiaro! D printer, rotate the ink tank to stir the ink.

Note: This step applies only to the Kiaro! D ink. If you are using the standard 
Kiaro!, skip this step.

5 Slowly insert the ink tank as far as it will go, and then close the ink tank lever. 
Repeat this step for each color.

Caution: There are sharp pins in the ink tank slot. Never put your fingers in this 
area.

Note: The printer is designed so that ink tanks cannot be inserted in the wrong ink 
tank slots. Do not attempt to insert ink tanks in the wrong ink tank slots forcibly.

6 After loading all ink tanks, close the ink tank door.
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Initial Ink Filling

Caution: Do not turn the power off or open covers and doors such as the Roll Cover 
during ink loading.

Caution: If the power is turned off or covers and doors are opened during ink loading, 
the printer stops ink loading. In such a case, turn on the power to start ink loading again.

Caution: Restarting the ink loading causes extra ink waste.

1 Connect the power cord to the printer. Several power cords come with the printer. 
Use the power cord appropriate for the power supply used at the installation site.

Caution: Never use a wrong power cord.

2 Connect the power cord to the outlet.

3 Press the POWER key for one second or more to turn on the power. Initial ink filling 
starts automatically when the power is turned on.

When ink loading is complete, the STATUS LED changes from flashing to lit and a 
beep sounds.

Note: Initial ink loading takes about 25 minutes.

4 If you are using the Kiaro! D printer, wait until ink loading has finished. Then 
remove the protective sheet from the transport area.
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Note: This step applies only to the Kiaro! D. If you are using the standard Kiaro!, 
skip this step.

Loading Media

Loading Media on the Roll Holder
1 While pushing the holder stopper release lever, remove the holder stopper from the 

roll holder.
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2 Load roll media on the roll holder with it oriented as shown such that the bottom of 
the roll touches the roll holder surface with no clearance.

3 While pushing the holder stopper release lever, insert the holder stopper until it 
stops.

Release the holder stopper release lever.
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Setting the Media in the Printer
1 Make sure that the Power LED stays lit. If the Power LED does not stay lit or it is 

not blinking, press the power key to put the printer in the power-on state.

2 Open the roll cover.

3 Push the lever of the paper guide to open the guide.
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4 Open the transport guide (right), and slide it rightward until it stops.

5 Mount the roll holder in the printer.
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6 If you are using gap or reflective mark media, cut the media edge that will be fed 
into the printer. If you are using continuous media, skip this step.

• If you are using gap media, cut the media between labels as illustrated by the 
dashed red line below. The arrow indicates the direction of media feed into the 
printer.

• If you are using reflective mark media, cut the media between labels, but 
before the mark, as illustrated by the dashed red line below. The arrow 
indicates the direction of media feed into the printer.
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7 Insert media along the left-side guide under the transport guide (left) until it stops 
at the roller in the feeder slot.

Media at the roller in the feeder slot is automatically pulled in slightly.

8 Slide the transport guide (right) in accordance with the width of the media.

Note: Do not press the transport guide (right) strongly against the media edge. A 
paper jam can result.

9 Slowly close the transport guide (right) to lock it.
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10 Slowly push the paper guide down until it clicks (locks). When it locks, media is 
transported automatically.

11 Close the roll cover.



Quick Start Guide

26 Kiaro! User Guide

Installing the Printer Driver (USB)
Use the following instructions to install the printer via USB 2.0 on Windows XP, 
Windows Vista, Windows 7, or Windows 8.

Note: When the Windows logo testing, publisher verification, or digital signing warning 
messages appear, choose to continue the installation. These messages indicate that 
the driver has not been “logo tested” by Microsoft. However, it has been tested 
thoroughly by QuickLabel, and will not cause any of the problems listed in these 
messages.

1 Ensure the Kiaro! is powered on but not connected to your computer via the USB 
cable.

2 Obtain the installer package from the QuickLabel web site. Launch the installer to 
open the installation wizard. Choose Next.

3 Use the driver installation wizard to install the driver. Refer to the following 
information during this process.

• Choose the USB connection method when prompted.

• Select an installation location for the Kiaro! Maintenance Utility when 
prompted.

Choose Finish in the installation wizard after successfully installing the Kiaro! 
Maintenance Utility and driver.

4 Connect the smaller end of the USB cable to the Kiaro! USB type B port.

Connect the larger end of the USB cable to an available USB 2.0 port on your 
computer.

5 Once the USB connection is made, the Windows Found New Hardware Wizard will 
start. This wizard will guide you through the rest of the installation process. Refer 
to the following general guidelines when using this wizard.

• If you are prompted to connect to Windows Update to search for software, 
choose no.
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• Choose to install the software automatically when you are presented with this 
option.

• If the Windows logo testing or publisher verification warning messages appear, 
choose to continue the installation.

Resolving Windows 7 and Windows 8 USB Installation 
Issues
When you install the printer driver via USB, you first run the installation wizard and then 
connect the printer to your PC via the USB cable.

If you connected the USB cable before running the installation wizard, Windows 7 and 
Windows 8 will not recognize the printer correctly. In this case, the Kiaro! will be listed 
as an Unspecified item in the Devices and Printers window.

Use the following procedure to correct this issue. This procedure assumes you have 
already installed the printer driver.

Note: This procedure requires administrator level access in Windows.

1 Open the Devices and Printers window in Windows 7 or Windows 8.
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2 Right-click the QuickLabel Kiaro in the Unspecified list. Then choose Properties. 
The QuickLabel Kiaro Properties window will open. Choose the Hardware tab.

3 Select AstroNova IncQuickLabel Kiaro and choose Properties. The Properties 
window will open. Choose the General tab.

4 Choose Change Settings. Then choose the Driver tab.
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5 Choose Update Driver. When you are prompted, select the Search automatically 
for updated driver software option. Windows will locate the driver on your system 
and create a printer item.

Installing the Printer Driver (Network)
Use the following instructions to install the printer via a network connection on Windows 
XP, Windows Vista, Windows 7, or Windows 8.

For detailed information about the topic of networking, refer to documentation 
applicable to your network environment and/or contact your network administrator.

The printer uses the following ports: TCP 50000,50001,9100, UPD 50001,50002. The 
printer cannot be used on a network where other devices on the network use the same 
ports.

Note: When the Windows logo testing, publisher verification, or digital signing warning 
messages appear, choose to continue the installation. These messages indicate that 
the driver has not been “logo tested” by Microsoft. However, it has been tested 
thoroughly by QuickLabel, and will not cause any of the problems listed in these 
messages.

1 Ensure the printer is powered on and connected to the network via a LAN cable.

2 Obtain the installer package from the QuickLabel web site. Launch the installer to 
open the installation wizard. Choose Next.

3 Use the driver installation wizard to install the driver. Refer to the following 
information during this process.

• Choose the Ethernet connection method when prompted.

• Allow the installer to access the network if prompted.

• Choose the Kiaro! printer in the printer list when prompted. Alternately, you can 
choose to find a specific printer by IP address or MAC address.
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• Configure the printer for DHCP or a static IP address.

Ensure the printer has been in the “Ready” state for at least 30 seconds before 
attempting to connect via DHCP or static IP address. Additionally, if you 
change the selection from static IP address to DHCP, wait at least 30 seconds 
before proceeding to allow the printer to establish DHCP communication.

• Select an installation location for the Kiaro! Maintenance Utility when 
prompted.

Choose Finish in the installation wizard after successfully installing the Kiaro! 
Maintenance Utility and driver.
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2 Introduction

About the Kiaro!
The Kiaro! is a ground-breaking inkjet color label printer that combines excellent print 
quality with high-speed label printing and low cost of ownership. When you use a Kiaro! 
to print your own labels, you can cut label costs and add more flexibility to your product 
packaging.

The Kiaro! digital color label printer was developed especially for manufacturers and 
processors who want to make fantastic-looking labels at high speeds (think 7,200 
labels per hour for labels 4 inches/101.6mm long). The Kiaro! color label printer 
instantly prints professional-quality labels at an attractive cost-per-label.

Where the Kiaro! stands apart from other inkjet label printers is that it doesn't require a 
speed/quality trade-off. The Kiaro! prints labels in high resolution faster than any other 
tabletop color label printer. Even at 8 ips output speed, you will get great looking, 
colorful, vibrant labels in an outstanding resolution of 1200 dpi. In fact, even when you 
engage the ink-saving Economy mode, you'll still print beautiful labels in 1200 dpi.

The compact size of the Kiaro! label printer makes it the perfect fit for a tabletop or work 
bench, easy to add to any production line or packaging room operation. The Kiaro! 
comes included with Custom QuickLabel® Omni labeling software to help you layout 
your labels, add barcodes, and manage multiple label print jobs. You also have the 
option to print labels directly from graphic design programs like Adobe® Photoshop® 
and Illustrator®.

To get started printing labels, contact your QuickLabel Media Specialist to stock up on 
blank labels and Kiaro! inks.
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Printer Part Names and Functions

Front View

# Part Description

1 Upper Unit Open this unit when loading media, removing 
media jams in the feed path, or cleaning inside 
the machine. This unit includes print modules, cir-
cuit boards, and other internal components.

2 Operation Panel Keys necessary for operation and LEDs to indi-
cate the state of the printer are provided on this 
panel.

3 Ink Tank Door Open this door when replacing ink tanks.

4 Manual Cutter Use this cutter to cut the ejected media manually.

5 Roll Cover This cover protects the roll media feeder.

6 Roll Cover Handle Use this handle to open the roll cover.

7 Cutter Cover Open this cover when using the manual cutter.

8 Maintenance Cartridge 
Door

Open this door when replacing the maintenance 
cartridge.

9 Media Delivery Slot Media is ejected through this slot.

[1]

[2]

[3]

 [5]

[6]

[9]

[4] [8]
[7]
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Back View

# Part Description

1 Rear Feeder Slot This slot is used to feed fanfold paper.

2 Rating Plate A serial number for identifying the printer is 
shown on this plate. The serial number is 
required when you ask for repair of the printer or 
to register yourself as a user.

3 RS232C Port Reserved.

4 RS232C Port This port is used for the external control interface. 
For more information, refer to the Kiaro! Com-
mand Interface Guide.

5 USB Port Connect a USB cable here to connect to the com-
puter.

6 LAN Port Connect a LAN cable here to connect to the com-
puter.

7 Power Socket Connect the power cord here.

[1]

[7]

[3]

[4]

[5]

[6]

[2]
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Inside the Printer

# Part Description

1 Transport Guide (Left) This is a fixed guide for transporting media 
straight.

2 Upper Unit Release 
Lever

Push this lever up to release the upper unit.

3 Pinch Roller Release 
Lever

Pull down this lever when media is jammed.

4 Transport Guide (Right) This guide is used to transport media straight and 
detect the width of the media.

5 Media Guide This guide prevents media from floating.

6 Roll Holder Mounting 
Brackets

Set the roll holder here.

7 Maintenance Cartridge Ink used to clean the print head is collected here.

8 Roll Holder This holder is used to set media.

9 Cleaning Stick Use this cleaning stick when cleaning the trans-
port assembly.

[2]

[3]

[5]
[4] [8]

[7]

[6]

[1]

[9]
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Roll Holder

Operation Panel

# Part Description

1 Holder Stopper This stopper prevents media from being 
removed.

2 Holder Stopper 
Lock/Release Lever

This lever is used to release the holder stopper. 
Push this lever when attaching or detaching the 
holder stopper.

# Part Description

1 Power Key/LED • On - Power is on.

• Blinking - Sleep mode.

• Off - Power is off.

2 PAUSE Key • Printing - Pressing this key suspends printing. 
Pressing this key for about one second during 
printing cancels all jobs to abort printing.

• Paused - Pressing this key restarts printing. 
Pressing this key for about one second during 
printing cancels all jobs to abort printing.

[1]
[2]

STATUS

ERROR
BK C M YMC

[1] [2] [3] [4]

[5][6]

[7]
[8]
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Switching the Printer On and Off

Switching the Printer On
Make sure that the power cable is connected properly, and then turn on the printer.

1 Press the power key for at least one second.

Cleaning is performed and the printer becomes ready for printing. When the printer 
is in the Online mode, the STATUS LED stays lit.

3 FEED Key Pressing this key in the offline mode feeds media.

4 BACK FEED Key Pressing this key feeds media one page back-
ward. Pressing and holding this key feeds media 
backward continuously.

5 Ink Warning LEDs • On - No ink or ink tank missing.

• Blinking - Low ink.

• Off - Sufficient ink.

6 Maintenance Cartridge 
Warning LED

• On - Full

• Blinking - Nearly full.

• Off - Sufficient room to collect ink.

7 ERROR LED • On - Operator-call error (can be recovered by 
user operation).

• Blinking - Fatal error.

• Off - Normal.

8 STATUS LED • On - Online mode.

• Blinking - Data being received (printing, 
cleaning, initializing, shut-down).

• Off - Offline mode (during cleaning, etc.).

# Part Description
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Note: When the printer is in sleep mode, press the power key to return the printer 
to online mode. The printer will also wake up from the sleep mode automatically as 
soon as it starts receiving a print job.

Switching the Printer Off
1 Press the power key for at least one second.

The Power LED blinks at long intervals, and then the printer is turned off.

When the printer is not used for a long period of time:

• To prevent media from discoloring, remove it from the roll holder. Store the 
removed media in a plastic bag or box such that it is not exposed to high 
temperature, high humidity, and direct sunlight.

• If the printer is to remain operational, it should be powered on to prime/clean 
the printheads every 8 weeks. If the printer is to be stored, it should be powered 
on to prime/clean the printheads every 2 weeks.
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QuickLabel Services

Kiaro! Label Materials
QuickLabel develops Kiaro! label printing substrates. We sell cost-effective labels that 
meet various end-use requirements, including industry and government regulatory 
labeling standards.

QuickLabel BPO Blanket Purchase Order Program
As the manufacturer of the Kiaro! and the supplies, QuickLabel has the advantage of 
providing you with lower prices due to production efficiencies. QuickLabel's Kiaro! BPO 
Program covers all of your requirements for printing supplies over a 12-month period. 
You receive a discounted price for your annual commitment and regular scheduled 
deliveries based on your production requirements. Customers who take advantage of 
our BPO program receive maximum savings on all of their ink and blank label 
purchases!

Media Specialists
QuickLabel offers the services of our highly trained label experts to advise you on 
choosing the right label material and on designing label files for custom and special 
label shapes.

Your personal Media Specialist is available to:

• Provide a point of contact for ongoing development of label materials that may be 
required for unique labeling applications

• Advise you on expected usage so you can plan purchasing and manage your 
inventory levels

• Advise you on our convenient blanket orders, which automate shipment of your 
supplies to your location on dates you specify in advance

• Take your orders for labels and new label shapes

• Take your orders for printer supplies

QuickLabel Kiaro! Support
We provide factory-direct technical support for the Kiaro! label printer, including 
ongoing maintenance, training, troubleshooting, and repair consultations. This support 
service is a standard part of the One Year Warranty that comes with your Kiaro! 
purchase.

We offer additional support in the form of an optional Customer Support Agreement, 
which acts as an extended warranty for your Kiaro!. The Customer Support Agreement 
provides for on-site visitation (as needed) and QuickSwap™ Repair and Replacement 
Service.
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Customer Support Agreements include:

• A Visit by a Service Technician - You are entitled to receive a service visit to your 
facility. Upon your request, we will schedule a technician to come to your facility 
within 5 business days.

These service visits are your opportunity to receive additional training in printer 
operation and maintenance to your staff, to have questions addressed in-person, 
and to iron out any production issues you might encounter. To get the most out of 
each visit, we encourage you to prepare a list of topics you want to cover and share 
it with us in advance.

Additional repair visits are available for a fee and are subject to travel expenses.

• QuickSwap™ - Under the QuickSwap™ Repair and Replacement Service, you 
receive replacement or repair of any faulty system parts, excluding those damaged 
by abuse or neglect, without cost.

Please note that the QuickSwap™ Service does not include printing supplies or 
wear parts. Discounted pricing on these items is available through the BPO Blanket 
Purchase Order Program.

• Unlimited Telephone Support - You receive free and unlimited technical support 
by telephone. We guarantee that when you call our technical support line, 
877-757-7310 in the USA, (see Contact Information for Factory Sales and Service 
in the front of this manual for telephone numbers in other QuickLabel locations), 
someone in our Technical Support Department will help you troubleshoot your 
problem or assist you in the use of your label printer.

For a Customer Support Agreement quotation, please contact QuickLabel.
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3 Designing and Printing Labels

Designing Labels
This section describes several factors you should consider before you start designing 
labels.

Choosing Design Software
You can print to the Kiaro! using any design software with printing functionality. There 
are many graphic design software applications available, and the programs you choose 
will depend on your desired workflow and design requirements.

Design software is available from QuickLabel and other software vendors.

• Custom QuickLabel Omni from QuickLabel - This software product, developed 
by QuickLabel, makes it easy to create barcodes and position text and graphics on 
a label.

• Third Party Applications - There are a variety of graphic design programs 
available from other software companies such as Adobe and Corel. Adobe 
Photoshop, Illustrator, and similar professional image editing programs provide 
advanced tools for creating your artwork.

A common scenario is to use a mixed approach to designing labels. For example, you 
may want to edit a photographic element in Photoshop, create a logo in Illustrator, and 
then place both into a Custom QuickLabel Omni file for final layout and printing.

Disabling Anti-aliasing
Most graphic design software applications provide anti-aliasing features that result in 
the appearance of smooth color transitions.

When designing labels that will be printed on the Kiaro!, do not use anti-aliasing. This 
is especially important if you are printing text or barcodes. For example, an anti-aliased 
barcode may not scan correctly due to the color transitions between lines.

Planning Full-Bleed and Non-Bleed Labels
In full-bleed labels, color prints up to the edge of the label. With non-bleed labels, color 
stops at a margin before the edge of the label.

Use the following guidelines when setting up a file for a full-bleed label.

• If you are using matrix-in media, the height and width of the label file “canvas” 
should be 0.25” (.63 cm) larger than the height and width of the physical label. This 
size will allow a bleed on all sides of the label (onto the matrix) while 
accommodating the printer’s minimal label wander.

• If you are using media with the matrix removed, you can print all the way to the 
edge of die-cut labels, but doing so may cause a small amount of ink to deposit 
onto the liner. In the event excess ink deposits on the liner, it will not dry and may 
smear onto other surfaces, including hands and other printed labels. As a 
guideline, no more than 0.02” (0.5 mm) of ink should be printed onto the liner.
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• Design elements that will run to the edge of the label are the parts of the design 
that will “bleed” across the edge. Your bleed will most commonly be a solid color, 
pattern, or gradient background running off the edge of the label.

Use the following guidelines when setting up a file for a non-bleed label.

• The height and width of the label file “canvas” should be the same as the height 
and width of the physical label.

• All design elements should be placed inside a .0625” (1.5 mm) border of the 
canvas. This will ensure such design elements never run to or over the edge of the 
label.

Printing Black
There are two ways to print black with the Kiaro! printer. The printing method will vary 
based on the RGB values of the black color being printed.

• True Black - This method uses only black ink when printing black. The RGB color 
values must all be between 0 and 1 to print in true black. For example, images with 
RGB values of 0,0,0 or 0,1,0 or 1,1,1 will print using only black ink.

• Process Black - This method uses a mixture of inks when printing black. If RGB 
color values are not between 0 and 1, process black will be used. For example, 
images with RGB values of 2,2,2 or 1,1,2 or 0,0,30 will print using a mixture of inks 
in a process black.

Setting up the Label Design Software
This section describes how to set up your label design software to print on the Kiaro!.

Setting up Labels in Custom QuickLabel Omni
Custom QuickLabel Omni is a software application developed by QuickLabel to access 
special features in our printers and allow customers to easily design and print labels.

For detailed label setup and printing instructions, please refer to the Custom 
QuickLabel Help.

Setting up Labels in Third-Party Design Applications
You can design and print label files exclusively within a third-party application such as 
Adobe Photoshop or Illustrator. In this situation, use the following guidelines to ensure 
best results.

Note: You can also use third-party applications to design components of a label to be 
imported into Custom QuickLabel Omni. In this situation, save or export graphic files in 
a .BMP, .PCX, uncompressed .JPG, uncompressed .TIF, .GIF, .PNG, or .PDF format.

• Select a resolution of 600 pixels per inch - For raster-based design applications 
such as Adobe Photoshop, choose a resolution of 600 pixels per inch. This will 
provide sufficient image resolution to produce superior 1200 pixel per inch output 
quality. This setting is not used in vector-based design applications such as Adobe 
Illustrator.
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• Use in-gamut colors - When designing in color, ensure you use colors that are 
within the printing gamut. Most design applications will indicate when a color is out 
of gamut.

For example, in Adobe Photoshop and Illustrator, out-of-gamut colors are indicated 
by an exclamation point icon in the Color palette.

Out-of-gamut colors cannot be accurately printed. There are often colors that can 
be found to replace out-of-gamut colors.

• If the application supports color management, enable it - Professional design 
applications support color management. This option is typically found in the 
application’s print window.

Ensure the Color Adjustment in the Kiaro! printer driver is set to “Application 
Managed”. Color management should be enabled in either the design application 
or printer driver, but not both.

Setting up the Printer Driver

Selecting a Label Stock
Before you print using a third-party application, you will need to select the appropriate 
label stock in the printer driver.

Note: Driver instructions apply only to printing via third party design applications. If you 
are using Custom QuickLabel Omni, this process is not required.

1 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

Right-click the printer icon and choose Printing Preferences. The QuickLabel 
Kiaro! Printing Preferences window will open.

Note: You can also access the driver preferences via the application’s print dialog. 
From the Print window in your software, select QuickLabel Kiaro! from the printer 
list and choose Properties or Setup (varies based on program).
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2 Choose the Label tab.

3 Select a label stock from the list.

Note: If necessary, you can set up a custom label stock to meet your needs.

4 Choose OK.

Related Topics: 
- Setting up a Custom Label Stock on page 44

Setting up a Custom Label Stock
You can add and modify custom label stocks in the printer driver.

Note: Driver instructions apply only to printing via third party design applications. If you 
are using Custom QuickLabel Omni, this process is not required.

1 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

Right-click the printer icon and choose Printing Preferences. The QuickLabel 
Kiaro! Printing Preferences window will open.

Note: You can also access the driver preferences via the application’s print dialog. 
From the Print window in your software, select QuickLabel Kiaro! from the printer 
list and choose Properties or Setup (varies based on program).
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2 Choose the Label tab.

3 Choose Manage Labels. The Manage Labels window will open.

Note: Choose the “Where do I find these values?” button to view a help topic that 
describes how to locate setup information about your labels.

4 Enter a name for the label stock.

5 Select whether to specify sizes in inches or millimeters.
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6 Enter the total width (TW) of the media construction, including the narrow portions 
of exposed liner near the edges of the media.

7 Enter the printable width (also called maximum printable width, or MPW). Do not 
include the narrow portions of exposed liner near the edges of the media.

8 Enter the label length (also called maximum printable length, or MPL).

• If you are using gap or reflective mark media, the MPL is printed on a label 
located inside the cardboard core of the label roll.

• If you are using continuous media, you will determine length based on the 
height dimension in your label file. You can view this dimension using your 
label design application software.

9 Select the type of material the label will be printed on.

10 Select a sensor type.

• Gap - Choose this option if you are using gap media.

• Reflective - Choose this option if you are using reflective mark media.

• None - Choose this option if you are using media without gap or reflective 
marks (continuous media).

When printing on continuous media, there will be an unprinted space of 
approximately 0.125” (3.175 mm) between labels.

If you selected Gap or Reflective, enter the length of the gap or reflective mark 
(also called GML).

11 Select how media is supplied to the printer.

• Internal Roll - Choose this option if you are using a roll of labels installed in 
the printer.

• External - Choose this option if you are feeding labels from a source outside 
of the printer.

12 Select the shape of the label.

13 If you are printing a full-bleed label, you can eliminate white space along the edges 
of the label by selecting vertical and horizontal bleed values. If a value is greater 
than zero, the printed label length/width will be slightly increased to bleed to the 
edge of the label.

Each vertical bleed degree increases the label length by .1 mm in the respective 
vertical direction. Each horizontal bleed degree increases the label width by .1 mm 
in the respective horizontal direction.

When using this option, design your label so the bleed area extends beyond the 
edges of the label “canvas” in your label design software.
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14 If necessary, use the offset options to adjust the location of a printed image relative 
to the registration marks on the media.

• Vertical Offset - Negative values move the image down on the label (out away 
from the printer). Positive values move the image up on the label (in toward the 
printer).

• Horizontal Offset - Negative values move the image left on the label. Positive 
values move the image right on the label.

15 Choose Add.

16 If necessary, you can edit or delete label stocks.

• To edit a label stock, select it from the list and modify its settings. Then choose 
Modify.

• To delete a label stock, select it from the list and choose Delete.

17 If necessary, you can import or export label stock information. This is helpful when 
transferring label stock settings between multiple computers.

• Import - Choose this option to import label stock information from a file.

• Export - Choose this option to export all label stock information to a file.

18 Choose OK.

Setting up Appearance Options
Before you print using a third-party application, you will need to select appearance 
options for your label.

Note: Driver instructions apply only to printing via third party design applications. If you 
are using Custom QuickLabel Omni, this process is not required.

1 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

Right-click the printer icon and choose Printing Preferences. The QuickLabel 
Kiaro! Printing Preferences window will open.

Note: You can also access the driver preferences via the application’s print dialog. 
From the Print window in your software, select QuickLabel Kiaro! from the printer 
list and choose Properties or Setup (varies based on program).
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2 Choose the Appearance tab.

3 Select a print quality.

• Best - If you select this option, labels will be printed with the best possible 
quality. Labels will be printed with 1200 dpi resolution.

• Fast - If you select this option, print jobs start sooner because there is less data 
sent to the printer. However, the actual printing speed is identical in best and 
fast modes. Labels will be printed with 600 dpi resolution.

• Economy - If you select this option, labels will be printed using less ink. This 
mode is best used for printing label proofs. Labels will be printed with 1200 dpi 
resolution.

4 Select whether color adjustment is automatic or controlled by the label design 
application software.

• Automatic - If you select this option, the printer driver will apply color 
adjustments. Use this if your design application does not support color 
adjustment, or if you want to manage color in the printer driver instead of the 
design application for simplicity.

Note: If you are managing color adjustment in the design application, do not 
enable this option, as it will result in two color adjustments: one in the 
application and one in the driver.

• Application Managed - If you select this option, the printer driver will not apply 
color adjustments. Instead, color will be managed by the application (Adobe 
Photoshop or Illustrator for example).

If you select Automatic, select the type of automatic color adjustment.
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• Perceptual - Perceptual rendering compresses the entire color source, both in 
and out-of-gamut colors, until all colors can be represented by the printer. This 
rendering changes all colors equally, and therefore maintains the relationship 
between each color. However, this also ensures that even in-gamut colors are 
changed, sometimes significantly, from their original tone.

• Relative Colorimetric - Relative colorimetric rendering scales the white point 
of the source image to match the white point of the target space. This ensures 
that all colors, while different from their original colors, at least maintain the 
same relationship to white. As in absolute colorimetric rendering, out-of-gamut 
colors are then mapped to the closest in-gamut color. This method provides a 
more consistent relationship to white, but alters in-gamut colors, and is still 
subject to the some of the gradation problems that occur with absolute 
colorimetric rendering.

• Absolute Colorimetric - Absolute colorimetric rendering alters only 
out-of-gamut colors, and does so by mapping them to the nearest in-gamut 
color. This results in no change to in-gamut colors, but can significantly alter 
relationships between in and out-of-gamut colors. This is often visible in the 
form of large “flat” looking areas, or areas with sudden, coarse tonal 
gradations.

• Saturation - Saturation rendering converts saturated simple colors in the 
source space to the same saturated basic colors in the print space, ignoring 
any differences in hue and lightness. Because of its simplicity, saturation 
rendering is best used on images with basic color use, as opposed to 
photographs, which will not render as well.

5 Choose OK.

Setting Advanced Color Options
Before you print using a third-party application, you can set advanced color options to 
define how colors on your label will be printed.

Note: Advanced color adjustment is rarely needed. Check the image in your design 
application before making adjustments in the Advanced Color Settings window.

Note: Driver instructions apply only to printing via third party design applications. If you 
are using Custom QuickLabel Omni, this process is not required.

1 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

Right-click the printer icon and choose Printing Preferences. The QuickLabel 
Kiaro! Printing Preferences window will open.
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Note: You can also access the driver preferences via the application’s print dialog. 
From the Print window in your software, select QuickLabel Kiaro! from the printer 
list and choose Properties or Setup (varies based on program).

2 Choose the Appearance tab.

3 Check Enable Advanced Settings to enable the settings defined in this 
procedure.

4 Choose Advanced Settings. The Advanced Color Settings window will open. 
Choose the General tab.

5 Set the general options.

• Gamma Correction - Select the amount of gamma correction that will be 
applied (1.4, 1.8, or 2.2). This option affects the darker regions of the image. A 
lower value lightens dark regions while a higher value makes them darker.
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• Sharpness - Select whether to adjust the image sharpness.

• Brightness - Select whether to adjust the image brightness.

• Contrast - Select whether to adjust the image contrast.

Choose Apply.

6 Choose the Color Balance tab.

7 Set the color balance options. You can choose whether to increase or decrease the 
cyan, magenta, yellow, and black colors.

Choose Apply.

8 Choose OK.

Setting up Layout Options
Before you print using a third-party application, you will need to select layout options to 
define how your label will be printed.

Note: Driver instructions apply only to printing via third party design applications. If you 
are using Custom QuickLabel Omni, this process is not required.

1 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

Right-click the printer icon and choose Printing Preferences. The QuickLabel 
Kiaro! Printing Preferences window will open.
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Note: You can also access the driver preferences via the application’s print dialog. 
From the Print window in your software, select QuickLabel Kiaro! from the printer 
list and choose Properties or Setup (varies based on program).

2 Choose the Layout tab.

3 If necessary, you can select a printing orientation. Orientation is often set within the 
design application. However, if you cannot select an orientation in the design 
application, choose from the following options:

• Portrait - Select this option if you want to print the label in a portrait orientation 
on the label roll.

• Landscape - Select this option if you want to print the label in a landscape 
orientation on the label roll.

4 If necessary, you can rotate the printed image 180 degrees by choosing Rotate 
180.

5 If necessary, you can print the image in a mirrored orientation by choosing Mirror 
Image.

6 If necessary, you can select a printing quantity. Print copies are specified within the 
application before printing. However, you can override that value here, or use this 
setting if the application does not provide a setting.

If you enable the Always Use Driver Setting option, the print quantity you specify 
in the driver will override the print quantity specified in your design application.
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7 If necessary, you can change the print speed. However, the Auto print speed is 
recommended. This option automatically adjusts printing speed based on the 
speed of the print job data received by the printer.

When the printer does not have enough data it will stop printing, wait for the 
required amount of data, then retract media to the next label and resume printing. 
If automatic speed is used, printing will continue at a slower speed. If a specific 
speed is selected, printing will continue at the same speed.

8 Select whether to enable first label priority mode. When this mode is enabled, a 
command will be sent to the printer at the start of a job. This command instructs the 
printer to start processes for preparing to print. This mode reduces the amount of 
time before the first label in a job starts printing.

9 If your Kiaro! printer has the auto-cutter accessory installed, you can set up the 
cutter.

• Check the Cutter Enabled option to enable the auto-cutter.

• Use the Labels Between Cut field to indicate the number of labels to print 
between each cut.

The minimum cut length is 1.496 inches (38 mm). If you choose to cut between 
each label, and the label length is shorter than the minimum cut length, the 
label will print and be advanced an additional label length plus 0.25 inches 
(6.35 mm) and then cut.

10 Choose OK.

Printing Labels
1 Ensure the label media has been loaded.

2 If you are printing from a third-party design application, ensure the printer driver 
preferences are configured.

3 Open the label file using the appropriate software. Then choose to print the label, 
and enter the number of copies you would like to print.

Note: If your software has a collate option, disable it before printing.
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4 Print the labels. The Status Monitor will automatically open and display information 
about printer and job status.

The job progress will be displayed in the Status Monitor.

If necessary, you can cancel the print job by choosing Cancel Job/Reset Error on 
the Status Monitor.

5 Receive the printed labels. At the end of the job, cut the label material with the 
manual cutter.

Note: Do not pull the printed labels in any direction as they exit the printer. Pulling 
the labels may result in a media jam.

Related Topics: 
- Using the Manual Cutter on page 55
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Using the Manual Cutter
After completion of label printing, cut the label using the manual cutter.

Warning: The cutter blade is sharp. Use caution to avoid personal injury or damage 
to clothing when working with cutting blades or around exposed blade surfaces.

1 Open the cutter cover.

2 Hold the printed label as shown. If the printed label is short, press the FEED key to 
eject paper to the position where you can hold the label with ease.
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3 Cut the label by moving the cutter as shown while pressing the cutter lightly.

4 Return the cutter to the original position, and then close the cutter cover.

Note: If the cutter has become extremely dull, contact QuickLabel Support. Do not 
disassemble the cutter.
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Using the Status Monitor

Viewing the Printer Status
1 Open the Kiaro! Status Monitor. You can access the Status Monitor from the 

Windows Start Menu, Kiaro! Maintenance Utility, or the printer driver.

• From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Status Monitor.

• In the Kiaro! Maintenance Utility, choose Status Monitor. 

• In the Kiaro! printer driver, choose Status Monitor from the Status tab.

2 You can view status information in the Printer Status area. This area will display 
informational, error, and warning messages related to your printer’s current status.

3 If necessary, you can initiate printhead cleaning if the printer is in the Ready, 
Sleeping, or Paused modes.

Three cleaning options are available (light, medium, and heavy). Start with light 
cleaning and then print a test label. If the issue is not resolved, repeat using the 
medium cleaning method. If the issue is still not resolved, repeat using heavy 
cleaning.

If multiple heavy cleanings do not resolve the issue, contact Technical Support.

4 If necessary, you can view help topics by choosing Help > Help Topics.

Viewing the Job Status and Cancelling Jobs
1 Open the Kiaro! Status Monitor. You can access the Status Monitor from the 

Windows Start Menu, Kiaro! Maintenance Utility, or the printer driver.

• From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Status Monitor.

• In the Kiaro! Maintenance Utility, choose Status Monitor. 



Designing and Printing Labels

58 Kiaro! User Guide

• In the Kiaro! printer driver, choose Status Monitor from the Status tab.

2 You can view print job information in the Job Status area.

3 If necessary, you can cancel an in-progress job by choosing Cancel Job.

Viewing Ink and Maintenance Cartridge Levels
1 Open the Kiaro! Status Monitor. You can access the Status Monitor from the 

Windows Start Menu, Kiaro! Maintenance Utility, or the printer driver.

• From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Status Monitor.

• In the Kiaro! Maintenance Utility, choose Status Monitor. 

• In the Kiaro! printer driver, choose Status Monitor from the Status tab.

2 You can view estimates of remaining ink percentages in the Ink Levels area.

3 You can view an estimate of the maintenance cartridge level percentage in the 
Maintenance Cartridge Level area.
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Managing Media Out with the Kiaro! Printer
On media out, the Kiaro! printer will reprint labels to ensure all labels have been printed. 
This action produces duplicate labels and the user will need a manual procedure to 
remove the duplicates, especially if the labels contain information such as barcodes, 
serial numbers, etc.

When the Kiaro! printer runs out of media before completing the print job, it will print all 
remaining labels including the unfinished, in-progress label when a new roll of labels is 
loaded in the printer.

For example, during a print job of 10 labels, the printer runs out of media while printing 
the 6th label and the 4th label does not reach the stop position. When media is loaded 
and printing resumes, printing will start with the 4th label and continue to the 10th label 
in the job.

A label is considered printed if it exited the Kiaro! and passed the stop position. All 
labels that did not pass the stop position prior to the media out condition will be 
reprinted.

Changing or Replacing Media

Removing a Media Roll
When changing media before completion of printing, use media of the same size as the 
media used so far. Using media of a different size can result in an error.

1 Open the roll cover.
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2 Push the lever of the paper guide to open the guide.

3 Open the transport guide (right), and slide it rightward until it stops.

4 While pressing the pinch roller release lever, pull out the media.
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5 Remove the roll holder.

6 Remove the roll holder. Remove the media roll from the roll holder.

Removing an Empty Media Roll
When the media has been used up, a message will be displayed on the Status Monitor 
and the printer will stop.

1 Open the roll cover.
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2 Locate the tape adhered at the trailing edge of the media.

3 Push the lever of the paper guide to open the guide.

4 Remove the tape.
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5 While pushing the pinch roller release lever, pull out media through the delivery 
slot.

6 Remove the empty roll holder. Remove the empty roll core from the roll holder.

Loading Media on the Roll Holder
1 While pushing the holder stopper release lever, remove the holder stopper from the 

roll holder.

2 Load roll media on the roll holder with it oriented as shown such that the bottom of 
the roll touches the roll holder surface with no clearance.
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3 While pushing the holder stopper release lever, insert the holder stopper until it 
stops.

Release the holder stopper release lever.

Setting the Media in the Printer
1 Make sure that the Power LED stays lit. If the Power LED does not stay lit or it is 

not blinking, press the power key to put the printer in the power-on state.

2 Open the roll cover.
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3 Push the lever of the paper guide to open the guide.

4 Open the transport guide (right), and slide it rightward until it stops.

5 Mount the roll holder in the printer.
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6 If you are using gap or reflective mark media, cut the media edge that will be fed 
into the printer. If you are using continuous media, skip this step.

• If you are using gap media, cut the media between labels as illustrated by the 
dashed red line below. The arrow indicates the direction of media feed into the 
printer.

• If you are using reflective mark media, cut the media between labels, but 
before the mark, as illustrated by the dashed red line below. The arrow 
indicates the direction of media feed into the printer.
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7 Insert media along the left-side guide under the transport guide (left) until it stops 
at the roller in the feeder slot.

Media at the roller in the feeder slot is automatically pulled in slightly.

8 Slide the transport guide (right) in accordance with the width of the media.

Note: Do not press the transport guide (right) strongly against the media edge. A 
paper jam can result.

9 Slowly close the transport guide (right) to lock it.
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10 Slowly push the paper guide down until it clicks (locks). When it locks, media is 
transported automatically.

11 Close the roll cover.
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4 Kiaro! Maintenance Utility

About the Maintenance Utility
The Kiaro! Maintenance Utility is installed during the driver installation process. The 
utility allows you to view printer information and perform a variety of maintenance 
functions.

Printer Information Tab
Use the Printer Information tab to view printer system information, upgrade printer 
firmware, and set the clock.

Viewing Printer Information
1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Printer Information tab.
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3 View the printer information.

• Printer - This section provides the serial number of the printer and the installed 
firmware version number.

• Environment - This section provides the current temperature and humidity of 
the printer location.

• Parts Counter - This section provides the percentage of service life used by 
the blade cleaner and purge unit. When an item reaches 100% of service life 
used, it must be replaced.

This section also provides the amount of media that has been transported 
through the system.

• Print Heads - This section provides the percentage of service life used by the 
printheads. If print quality is acceptable, you can continue to use a printhead 
past 100% of its service life.

This section also provides the serial numbers and installation dates for 
printheads.

Related Topics: 
- Parts Replacement Tab on page 93

Upgrading the Printer Firmware
1 Ensure a Kiaro! Firmware file (*.udf) is accessible from your PC.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Printer Information tab.

4 Choose Update Firmware. The Upgrade Firmware window will open.

5 Choose the ... button. Browse to the Kiaro! Firmware file (*.udf) and choose Open.

6 Choose Send to Printer.

A progress indicator will be displayed and the printer firmware will be upgraded. 
When this process is complete, the printer will restart automatically.
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Setting the Clock
1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Printer Information tab.

3 To set the date/time controls to the current date/time as defined by your Windows 
clock, choose Get Current Time.

4 To read the time from the printer's internal clock and set the date/time controls 
accordingly, choose Read From Printer.

5 To set the printer’s internal clock, select a date/time with the controls and choose 
Save to Printer.

Print Settings Tab
Use the Print Settings tab to adjust the vertical baseline, horizontal baseline, cut 
position, stop position, and heavy-color mode.
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Setting the Vertical Baseline
The gap and reflective vertical baseline settings adjust the start of printing for gap or 
reflective media. You can adjust the baseline -200 to +200 dots.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Print Settings tab.

3 To read the vertical baseline values from the printer and set the Gap and 
Reflective controls accordingly, choose Read From Printer.

4 Enter vertical baseline values for Gap and Reflective media.

In the following illustration, a label is exiting the printer. Note the positive and 
negative adjustment directions.

5 To save the vertical baseline values, choose Save to Printer.

Setting the Horizontal Baseline
The horizontal baseline setting adjusts the horizontal position of the printed image. You 
can adjust the baseline -200 to +200 dots.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.
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2 Choose the Print Settings tab.

3 To read the horizontal baseline value from the printer and set the Horizontal 
Baseline control accordingly, choose Read From Printer.

4 Enter a horizontal baseline value.

In the following illustration, a label is exiting the printer. Note the positive and 
negative adjustment directions.

5 To save the horizontal baseline value, choose Save to Printer.

Setting the Cut and Stop Positions
The Cut Position and Stop Position settings adjust the position at which the media is 
fed after printing.

• If you are using an optional cutter, media is fed based on the Cut Position setting.

• If you are not using an optional cutter, media is fed based on the Stop Position 
setting.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Print Settings tab.

3 To read the cut position and stop position values from the printer and set the Cut 
Position and Stop Position controls accordingly, choose Read From Printer.
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4 Enter a cut position value. This value will be used when an optional cutter is 
attached.

• Positive values result in more media being fed after printing before the media 
stops.

• Negative values result in less media being fed after printing before the media 
stops.

You can adjust the cut position -10 to +10 mm.

5 Enter a stop position value. This value will be used when an optional cutter is not 
attached.

• Positive values result in more media being fed after printing before the media 
stops.

• Negative values result in less media being fed after printing before the media 
stops.

You can adjust the stop position -10 to +121 mm.

6 To save the cut position and stop position values, choose Save to Printer.

Using Heavy-Color Mode
Heavy-color mode should be enabled when printing full-flood dark process-color labels 
to improve cross-web density.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Print Settings tab.

3 To read the heavy-color mode setting from the printer and set the 
Disabled/Enabled control accordingly, choose Read From Printer.

4 Select whether to enable or disable heavy-color mode.

5 To save the heavy-color mode setting, choose Save to Printer.
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Cleaning Tab
Use the Cleaning tab to clean the printheads, prepare the printer for transport, and 
prime the printheads. Also use this tab to convert the printer to accept magenta+ ink. If 
you are using the Kiaro! D printer, use this tab to refresh ink.

Cleaning Printheads
If you suspect print quality issues related to banding, clogged nozzles, or printing 
defects, you might want to initiate a cleaning.

Printhead cleaning cannot be done during a print job or if an error is occurring. When 
cleaning is in progress, do not perform any other operation.

Note: Cleaning the printhead consumes ink. Clean the printhead only when 
necessary.

The cleaning options discussed in this procedure are also available in the Status tab 
of the Kiaro! printer driver and the Cleaning menu of the Kiaro! Status Monitor.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.
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3 Choose a cleaning option.

Three cleaning options are available (light, medium, and heavy). Start with light 
cleaning and then print a test label. If the issue is not resolved, repeat using the 
medium cleaning method. If the issue is still not resolved, repeat using heavy 
cleaning.

If multiple heavy cleanings do not resolve the issue, contact Technical Support.

Preparing for Moving
Before moving the printer a short distance in your building, such as to a different floor, 
prepare it using the following instructions. This procedure will drain ink from the 
printhead to avoid leakage when moving the printer a short distance.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose Moving. Follow the on-screen instructions to complete this procedure.

Preparing for Shipping
Before shipping the printer over long distances, prepare it using the following 
instructions. This procedure will drain ink from the entire printer when shipping the 
printer or moving longer distances.

1 Ensure the message “Maintenance cartridge near full” is not displayed in the Status 
Monitor. If the warning message is displayed, replace the maintenance cartridge 
with a new one, and then start the work.

Note: If the Shipping function is executed while the warning message is displayed, 
the maintenance cartridge would be filled with waste ink and the printer would be 
shut down, incurring extra time.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Cleaning tab.

4 Turn the printer power off and then back on to ensure the printer will not enter a 
sleeping state during the shipping process. The printer entering sleep mode at any 
point of the shipping process could result in a failure to complete the shipping 
process correctly.

5 Choose Shipping. Follow the on-screen instructions to complete this procedure. 
The ink will be drained from the printer.
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6 Power off the printer.

7 Pack the printer in its original packing material for shipping.

Exposing the Printhead for Manual Cleaning
Use the following instructions to expose the printhead for cleaning during the manual 
cleaning procedures discussed in the user guide.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose the Expose Printhead button.

The printer head will move to the print position for cleaning. This process requires 
five seconds.

Note: Do not keep the printhead in the print position for longer than two minutes.

Related Topics: 
- Cleaning the Printhead Face on page 102
- Cleaning the Inside Edge of the Printhead on page 104

Removing the Purge Unit for Manual Cleaning
Use the following instructions to remove the purge unit for cleaning during the manual 
cleaning procedures discussed in the user guide.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose the Clean Purge Unit button.

Use the maintenance wizard to remove the purge unit for manual cleaning.

Related Topics: 
- Cleaning the Purge Unit Blade on page 105



Kiaro! Maintenance Utility

78 Kiaro! User Guide

Priming the Printheads
Priming fills the printhead with ink when a heavy cleaning does not resolve a severe ink 
non-discharge problem.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose Prime. Follow the on-screen instructions to complete this procedure.

Converting to Magenta+ Ink
Magenta+ ink is a new and improved formulation that extends the magenta color gamut 
of your Kiaro! label printer.

The original magenta ink has been discontinued and replaced by the new magenta+ 
formulation. When you are ready to start using magenta+ ink, use the following 
procedure to convert the printer.

The conversion procedure purges existing magenta ink from the system and prepares 
the printer for accepting a new magenta+ ink tank.

Caution: After converting to magenta+ ink, your printer cannot be configured to use 
the original magenta ink formulation. Use only magenta+ ink tanks when replacing 
magenta color ink in the future.

Note: If the Convert to Magenta+ button is disabled in the Cleaning tab, magenta+ ink 
is already in use and this conversion procedure is not necessary.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose Convert to Magenta+. Follow the on-screen instructions to complete this 
procedure.

4 After the printer has been converted, you may install a magenta+ ink tank. Ensure 
that you only use magenta+ ink tanks when installing magenta color ink.

Original magenta and magenta+ ink tanks look similar, but you can identify them 
by their markings.
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• Magenta+ ink (part number 14731212) packaging and ink tank marking 
differences are illustrated below

• Magenta ink (part number 14731202) packaging and ink tank marking 
differences are illustrated below
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Refreshing Kiaro! D Ink
Due to pigment components, Kiaro! D ink requires periodic refreshing to maintain an 
optimum mixture. The status monitor will prompt you to refresh ink as needed.

Note: This feature applies only to the Kiaro! D ink. If you are using the standard Kiaro!, 
this procedure is not needed.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Cleaning tab.

3 Choose Refresh Ink. Follow the on-screen instructions to complete this procedure.

Test Print Tab
Use the Test Print tab to print test patterns.
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Printing a Test Pattern
1 Ensure that 4x5 media is loaded.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Test Print tab.

4 Choose Print Nozzle Check Pattern to print solid and shade patterns of each 
color.

Adjustments Tab
Use the Adjustments tab to set color registration and top-of-form adjustment options.

Setting up Standard Registration
1 Ensure that 4x5 media is loaded.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.
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3 Choose the Adjustments tab.

4 Choose Standard. The Head Adjustments window will open.

5 Enter the number of test patterns to print, and then choose Print Registration 
Pattern.

6 Use a magnifying glass or loupe to examine the patterns closely. The top pattern 
is used for vertical registration, and the bottom pattern is used for horizontal 
registration. Note if vertical or horizontal adjustments are needed based on color 
alignment.
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7 Adjust the horizontal and vertical registration of each color.

Magenta (M) is the reference color. Black (K), cyan (C), and yellow (Y) adjustments 
are made relative to magenta.

In the following illustration, a label is exiting the printer. Note the positive and 
negative adjustment directions.

8 Choose Send. The standard color registration settings will be saved.

Setting up Manual Registration
1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Adjustments tab.
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3 Choose Manual. The Head Adjustments window will open.

4 Manual registration can be adjusted for three media width groups, or brackets. 
Select the width bracket you will adjust.

• 73 mm (2.87 in) or larger

• 35.1 mm (1.38 in) to 72.9 mm (2.86 in)

• 35 mm (1.37 in) or less

When you select a bracket, the current settings for the bracket will be displayed in 
the Adjustments section.
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5 Adjust the horizontal and vertical registration of each color.

Magenta (M) is the reference color. Black (K), cyan (C), and yellow (Y) adjustments 
are made relative to magenta.

In the following illustration, a label is exiting the printer. Note the positive and 
negative adjustment directions.

6 Choose Send. The manual color registration settings will be saved.

Using the Missing Nozzle Adjustment
If a printhead nozzle is not functioning properly, you may notice small vertical lines of 
missing color on printed labels. If a nozzle is clogged, you can often resolve the issue 
using the cleaning functions.

If multiple cleanings do not resolve the issue, a nozzle may no longer be functioning. 
In this case, you can use the missing nozzle adjustment procedure to identify 
non-functioning nozzles. The printer will apply more ink from nozzles adjacent to 
non-functioning nozzles in an attempt to compensate for the missing nozzle.

Note: This adjustment works best when correcting an issue with a single nozzle. The 
adjustment is not recommended in situations with multiple consecutive non-functioning 
nozzles, or in situations with clogged nozzles.

1 Ensure that 4x5 media is loaded.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Adjustments tab.
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4 Choose Missing Nozzle Adjustment. The Missing Nozzle Adjustment window will 
open.

5 Choose Print Missing Nozzle Adjustment Pattern. The pattern will be printed.
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6 Examine the pattern for missing lines within the grids. Note the locations of any 
missing lines for each color grid.

In the following example of the black printhead pattern, the missing line is located 
in the vertical (x) coordinate of 50, and the horizontal (y) coordinate of 9 on the grid.

7 To read the adjustment list from the printer and populate the adjustment list 
accordingly, choose Refresh List.

8 Enter an adjustment for each missing line.

• Head - Select the color of the missing line. In the previous example, a missing 
line appeared in the black pattern.
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• Page - Choose whether the missing line is on the first or second test page for 
the selected color. In the previous example, the missing line occurred on page 
one of the two-page black pattern.

• Row - Enter the row number of the missing line. In the previous example, the 
missing line occurred in row 50.

• Column - Enter the column number of the missing line. In the previous 
example, the missing line occurred in column 9.

Choose Add to List to add the missing line to the adjustment list. Repeat this 
process for all missing lines.

9 If necessary, you can delete items from the adjustment list by selecting the item 
and choosing Remove from List.

10 When you are finished entering adjustments, choose Print Confirmation Pattern. 
The pattern will be reprinted, but with your adjustments applied. Examine the 
pattern to ensure the missing lines you entered now appear correctly.

11 Choose Close when you are finished entering missing nozzle adjustments.

Related Topics: 
- Cleaning Printheads on page 75

Turning on Top of Form Auto-Calibration
By default, the printer automatically calibrates the top of form for your label media. 
However, if you use reflective media, you may need to use the Top of Form Calibration 
feature in the Adjustments tab. In this case, the printer will calibrate top of form based 
on that procedure instead.

If you not using reflective mark media, the use of auto-calibration is recommended.

Use the following instructions to restore top of form auto-calibration.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Adjustments tab.

3 Choose Turn Auto-Calibration On.

Related Topics: 
- Calibrating Top of Form on page 88

Calibrating Top of Form
After loading reflective mark media, you may need to calibrate the printer.

This procedure is required only for reflective mark media. It should be performed each 
time a reflective mark media roll is loaded.
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If you have already calibrated the printer for your reflective mark media, and you are 
replacing a reflective mark media roll with an identical roll, repeating calibration is not 
necessary.

1 Temporarily remove the label roll from the printer.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Adjustments tab.

4 Choose Top of Form Calibration. The Top of Form Calibration window will open.

5 Determine if you are using matrix-in or matrix-out media. The next action will vary 
based on whether the matrix is intact or removed.

• Matrix-In - If your media has die cuts and the matrix has been left intact, no 
further preparations are needed. Please proceed to the next step.

• Matrix-Out - If your media has spaces between each label resulting from the 
removal of the matrix during the die cutting process, remove 160mm (6.5 
inches) of label material from the end of the media roll.

This process improves sensor accuracy by allowing a small portion of the label 
liner to advance through the printer before any label material is introduced.

6 Reload the label roll into the printer and close the roll cover.

7 Press and hold the FEED key on the printer control panel. Release the key when 
a label starts exiting the front of the printer.

8 Choose Save Calibration in the Top of Form Calibration window.

9 Choose Close.

Related Topics: 
- Turning on Top of Form Auto-Calibration on page 88
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Adjusting the Top-of-Form Threshold
If any of the following errors occur while using reflective mark media, you may need to 
calibrate the top-of-form sensor threshold. The following table describes the types of 
adjustments needed for each error condition.

Note: Before adjusting the top-of-form threshold, verify that your media has been 
loaded and configured correctly.

If you have already adjusted the top-of-form threshold for your reflective mark media, 
and you are replacing a reflective mark media roll with an identical roll, repeating this 
adjustment is not necessary.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Adjustments tab.

Error # Error Name

Sensor Adjustment
Adjust-

ment ValueInternal Cutter

1002 No paper Increase NA +0.2V

1102 Paper length is too short Increase NA +0.2V

1104 Paper length is too short NA Increase +0.2V

1301 Paper jam occurred Decrease NA -0.2V

1302 Paper jam occurred Decrease NA -0.2V

1304 Paper jam occurred NA Increase +0.2V

1305 Paper jam occurred NA Decrease -0.2V

1306 Paper jam occurred NA Increase +0.2V

130C Paper jam occurred Increase NA +0.2V

1402 Gap/Mark width error Decrease NA -0.2V

1403 Gap/Mark width error Increase NA +0.2V
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3 Choose Threshold Adjustment. The Threshold Adjustment window will open.

4 To read the internal sensor and cutter sensor values from the printer and set the 
Internal Sensor and Cutter Sensor controls accordingly, choose Read From 
Printer.

5 Enter an adjustment based on the error message table above. You will adjust either 
the internal sensor or cutter sensor.

• Internal Sensor - If an optional cutter is not installed, the printer’s internal 
sensor will require adjustment as described in the error message table.

• Cutter Sensor - If an optional cutter is installed, the cutter’s sensor will require 
adjustment as described in the error message table.

6 Choose Save to Printer. The threshold settings will be saved.

System Logs Tab
Use the System Logs tab to view the error history and save log files. It also provides 
a convenient way to e-mail QuickLabel Support.
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Viewing the Error History
1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the System Logs tab.

3 Use the scroll bars to browse the error history of the printer.

4 To refresh the error list, choose Reset.

Saving Log Files
1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the System Logs tab.

3 Choose the type of log you want to save.

• Save History to File - Choose this option to save the error history to a text file 
on your PC.

• Save Printer Settings to File - Choose this option to save the printer’s 
registration, consumable levels, and other settings to a text file on your PC.

• Save System Logs to File - Choose this option to save the system logs to a 
file on your PC. System logs contain detailed technical information that will be 
useful only to QuickLabel Support. These files are not intended for user 
analysis.

After the log file is created, a message will appear indicating the log was created 
successfully.



Kiaro! Maintenance Utility

Kiaro! User Guide 93

Parts Replacement Tab
Use the Parts Replacement tab to replace printheads, purge units, and blade 
cleaners.

Replacing the Printhead Assembly
Use the following procedure to replace the printhead assembly. This process will 
replace the printhead for each color.

Note: Wear protective gloves to prevent ink from staining your hands during this 
procedure.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Parts Replacement tab.

3 Select Head. Then choose Start. Follow the on-screen instructions to complete 
this procedure.
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Replacing the Purge Unit
Use the following procedure to replace the purge unit.

Note: Wear protective gloves to prevent ink from staining your hands during this 
procedure.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Parts Replacement tab.

3 Select Purge Unit. Then choose Start. Follow the on-screen instructions to 
complete this procedure.

Replacing the Blade Cleaner
Use the following procedure to replace the blade cleaner.

Note: Wear protective gloves to prevent ink from staining your hands during this 
procedure.

1 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

2 Choose the Parts Replacement tab.

3 Select Blade Cleaner. Then choose Start. Follow the on-screen instructions to 
complete this procedure.
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Advanced Tab
The Advanced tab is reserved for use only by Technical Support.
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5 Printer Maintenance

Replacing Ink Tanks
When the remaining ink level becomes low, a low ink message will be displayed on the 
Status Monitor to notify you that the corresponding ink tank will soon be out of ink. 
When an ink tank is out of ink, an out of ink message will be displayed and printing will 
stop.

The printer has four ink tanks: black (Bk), cyan (C), magenta (M), and yellow (Y). 
Confirm the message displayed on the Status Monitor and replace the appropriate ink 
tank.

Warning: For safety, keep ink tanks out of the reach of children. If ink is accidentally 
ingested, contact a physician immediately.

• To maintain printhead quality, the printer stops operating before it is completely out 
of ink. Therefore, a small amount of ink remains in the ink tank to be replaced.

• To get good printing results, use up each ink tank within six months of opening the 
package.

• Do not remove an ink tank unless you must replace it. This could shorten the life 
of the consumables. Ink tanks are only guaranteed for five re-punctures.

• Complete the ink tank replacement procedure as quickly as possible. Do not leave 
the printer with ink tanks removed.

• An ink tank left in a high-temperature place can deform. However, there is nothing 
wrong with its functions. It is recommended that ink tanks be stored where 
temperature does not rise extremely.

• Be careful not to stain your clothes or the surrounding area by the used ink tank.

1 Open the ink tank door.
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2 Open the ink tank lever while pushing it downward.

3 Remove the empty ink tank.

4 Take out the ink tanks from the package. Then remove the packing materials.

Do not touch the ink outlet and terminal to prevent soiling of the surrounding work 
area, damage to the ink tank, and poor printing. Never drop or apply excessive 
force to an ink tank.

5 If you are using the Kiaro! D printer, rotate the ink tank to stir the ink.
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Note: This step applies only to the Kiaro! D ink. If you are using the standard 
Kiaro!, skip this step.

6 Slowly insert the ink tank as far as it will go, and then close the ink tank lever.

Caution: There are sharp pins in the ink tank slot. Never put your fingers in this 
area.

Note: The printer is designed so that ink tanks cannot be inserted in wrong ink 
tank slots. Do not attempt to insert ink tanks in wrong ink tank slots forcibly.

7 Close the ink tank door.

8 Dispose of the old ink tank according to federal, state, and local laws after packing 
it in a plastic bag and placing the bag in the box.
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Replacing the Maintenance Cartridge
When the maintenance cartridge is filled with the collected ink, the message 
“Maintenance cartridge full error” is displayed in the Status Monitor and the printer 
stops.

Note: For safety, keep the maintenance cartridge out of the reach of children. If ink is 
accidentally ingested, contact a physician immediately.

• To prevent ink from leaking from a used maintenance cartridge, avoid dropping the 
cartridge or storing it at an angle. Otherwise, ink may leak and cause stains.

• Ink adheres to the top of the maintenance cartridge after it has been used. Handle 
the maintenance cartridge carefully during replacement. The ink may stain 
clothing.

1 Open the maintenance cartridge door.

2 Draw out the maintenance cartridge slowly.

When removing the maintenance cartridge full of ink, take care not to incline or 
drop it. The spilled or scattered ink may stain the floor or clothing.
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3 Insert a new maintenance cartridge.

The error message on the Status Monitor will disappear, and printing will start.

4 Dispose of the old maintenance cartridge according to federal, state, and local laws 
after packing it in a plastic bag and placing the bag in the box.

Upgrading the Printer Firmware
1 Ensure a Kiaro! Firmware file (*.udf) is accessible from your PC.

2 Launch the Kiaro! Maintenance Utility.

From the Windows Start Menu, choose Start > All Programs > QuickLabel 
Kiaro! > Kiaro! Maintenance Utility. A language and printer prompt will open.

Select a display language and the Kiaro! printer you want to connect to. Choose 
OK.

3 Choose the Printer Information tab.

4 Choose Update Firmware. The Upgrade Firmware window will open.

5 Choose the ... button. Browse to the Kiaro! Firmware file (*.udf) and choose Open.

6 Choose Send to Printer.

A progress indicator will be displayed and the printer firmware will be upgraded. 
When this process is complete, the printer will restart automatically.
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Printhead and Purge Unit Cleaning

Cleaning the Printhead Face
If a void appears on the label and persists after multiple heavy cleanings, or if 
debris/adhesive has attached to the printheads, use the following procedure to clean 
the printhead face.

Note: Ensure the printer power remains on during this procedure.

1 Print a Check Nozzle Pattern using the Test Print tab in the Kiaro! Maintenance 
Utility. Determine the position of voiding.

2 Open the roll cover. Remove the labels from transportation area (rewind the roll). 
Then close the roll cover.

3 Use the Expose Printhead function in the Kiaro! Maintenance Utility to expose the 
printhead for cleaning. See “Exposing the Printhead for Manual Cleaning” on page 
77.

The printer head will move to the print position for cleaning. This process requires 
five seconds.

Note: Do not keep the printhead in the print position for longer than two minutes.

4 Open the upper unit.

5 Set the Nozzle Check Pattern label face-up in the transport assembly, aligned to 
the transport unit's rib A as indicated in the image below.
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6 Find the void on the printed label and take note of where and which printheads are 
affected by non-discharging nozzles.

7 Touch the tip of cleaning stick on nozzles that have non discharge, and then hold 
for five seconds to absorb ink.

Caution: Do not touch cut section of cleaning stick on face of Printhead. Do not 
touch Printhead surface with your hand.

Note: It is possible to clean Printheads of all 4 colors with 1 cleaning stick.

Y
M
C
Bk

Y
M
C
Bk

Cut Section
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8 Confirm ink is absorbed in tip of cleaning stick, and then wipe Printhead from front 
side to rear side two or three times. Wiping direction is opposite direction of paper 
feeding.

Caution: Touch cleaning stick to the face of Printhead so tip of cleaning stick 
bends lightly.

9 Remove printed label used for finding non-discharge nozzles.

10 Close the upper unit. After closing the upper unit, the printer head goes back to 
normal position (capped position).

11 Open the roll cover. Reinstall the label roll. Then close the roll cover.

12 Print the Check Nozzle Pattern again to confirm whether the voiding is resolved or 
not.

Note: If the printhead is in the print position for an extended period of time, the 
printhead surface may dry and voiding may occur in other areas. If voiding occurs, 
use the Light cleaning procedure in the Cleaning tab.

Related Topics: 
- Exposing the Printhead for Manual Cleaning on page 77

Cleaning the Inside Edge of the Printhead
If label adhesive has adhered to the inside (upstream) edge of the printhead, print 
quality issues may result. Use this procedure to clean the inside edge.

Note: Ensure the printer power remains on during this procedure.

1 Open the roll cover. Remove the labels from transportation area (rewind the roll). 
Then close the roll cover.

2 Use the Expose Printhead function in the Kiaro! Maintenance Utility to expose the 
printhead for cleaning. See “Exposing the Printhead for Manual Cleaning” on page 
77.

The printer head will move to the print position for cleaning. This process requires 
five seconds.

Note: Do not keep the printhead in the print position for longer than two minutes.

3 Open the upper unit.

Front Side

Front 
Side

Rear
Side

Wipe Direction
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4 Use the tip of the cleaning stick to clean the inside edge of the printhead as 
indicated. Wipe the edge in the upward direction only. Do not wipe in the downward 
direction. Do not wipe in the left/right direction.

5 Close the upper unit. After closing the upper unit, the printer head goes back to 
normal position (capped position).

6 Open the roll cover. Reinstall the label roll. Then close the roll cover.

Related Topics: 
- Exposing the Printhead for Manual Cleaning on page 77

Cleaning the Purge Unit Blade
If debris has adhered to the blade in the purge unit, print quality issues may result. Use 
this procedure to clean the purge unit blade.

Note: Wear protective gloves to prevent ink from staining your hands during this 
procedure.

Note: Use only a new cleaning stick for this procedure. Do not reuse cleaning sticks 
when cleaning the purge unit blade.

1 Use the Clean Purge Unit function in the Kiaro! Maintenance Utility to remove the 
purge unit for cleaning. See “Removing the Purge Unit for Manual Cleaning” on 
page 77.
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2 Refer to the illustration during the cleaning process. Use a new cleaning stick to 
wipe the top surface of the blade (A, B, C, and D) in the directions indicated by the 
arrows.

3 After wiping the top surface, wipe the face surface of the blade (A, B, C, and D). 
Then wipe the back surface of this blade.

4 Reinstall the purge unit and complete the maintenance wizard.

Related Topics: 
- Removing the Purge Unit for Manual Cleaning on page 77

Do not clean

A

B

C

D
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6 Troubleshooting

Error and Warning Messages

Operator Call Error Messages

Error Messages Problem Solution

Upper unit open The upper unit is open. Close the upper unit [1].

Ink tank door open The ink tank door is open. Close the ink tank door 
[2].

Maintenance cartridge 
door open

The maintenance car-
tridge door is open.

Close the maintenance 
cartridge door [3].

Paper guide open The paper guide is open. Close the paper guide [4].

Roll cover open The roll cover is open. Close the roll cover [5].

[1]

[2]

 [5]

[3]

[4]
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Removing a Paper Jam
If a paper jam occurs during printing, an error message will be displayed and printing 
will be suspended.

1 Open the roll cover.

2 Press down the upper unit open lever (at the back of the feeder) to open the upper 
unit.
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3 While pushing the pinch roller release lever, pull out the paper jammed in the 
transport section.

Caution: When pulling out the jammed paper from the transport section with the 
upper unit open, take care not to touch the spur inside the upper unit. You can get 
injured or stained with ink.

4 Neatly cut the pulled out paper.

5 While pushing the pinch roller release lever, pull out paper in the direction opposite 
to the transport direction.
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6 Close the upper unit.

Note: When closing the upper unit, take care not to touch the interface at the back 
with your finger. Your finger can be caught in the interface, resulting in injury.

7 Reload media.

Printer Not Operating Correctly

Power Off

Check Point Solution

Main power switch is at the off position. Press main power switch to the on posi-
tion.

Printer power cord unplugged. Make sure that the power cord is 
plugged in completely.

Power supply not providing power. Connect another device to the power 
supply to confirm that the outlet is pro-
viding power. If you cannot restore the 
printer to normal operation, contact 
QuickLabel Support.
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Printer Does Not Start or Printer Stops During Print Jobs

Check Point Solution

Upper unit, ink tank door, or mainte-
nance cartridge door open.

Close the upper unit, ink tank door, or 
maintenance cartridge door and ensure 
it is closed tightly.

Printer is not connected to the com-
puter.

Check the USB cable and make sure 
that it is connected to the printer and the 
computer.

The USB cable is too long. Avoid using USB cables longer than 
16.4 feet (5 meters).

Media is not loaded correctly. Load media correctly.

The ink tanks are not installed correctly. Check the ink tanks and make sure that 
they are installed correctly.

The printer driver is not selected on the 
computer.

Make sure that the Kiaro! printer is 
selected when you start the print job.

Print data contains an image with a 
large capacity.

If you see the STATUS LED flashing, 
this means data is processing. Wait for 
the processing to finish.

The printer has been printing for a long 
period.

If the printer prints for a long period the 
printhead may overheat. To protect the 
printhead, the Status Monitor will display 
a printhead overheated message and 
stop the print job. Just wait for the print-
head to cool down.

The print destination port setting is 
wrong.

Open the printer driver Properties and 
make sure that the port setting is cor-
rect. If the port setting is not correct, 
shut down Windows, switch off the com-
puter, then reconnect to the selected 
port. Follow the procedure below to 
check the port setting.

Open the printer driver Properties win-
dow and then click the Ports tab. If you 
are using a USB connection, make sure 
that USBnnn (nnn represents numbers) 
is selected for the port setting.
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Paper is Not Feeding Correctly

Check whether a test pattern is printed.

Note that 4” x 5” label stock is required.

Try printing a test pattern from the Test 
Print tab in the Maintenance Utility.

If the test pattern is printed, check the 
application software settings, operation 
method, and print data content.

If the test pattern is not printed, contact 
QuickLabel Support.

The problem is occurring on the com-
puter.

Shut down the computer and switch it 
on again. Then try to print. Be sure to 
cancel the print job if it remains after the 
computer is restarted.

Check whether an option other than 
“None” is selected for the system 
standby setting or sleep mode setting of 
Windows running on the computer.

When printing data, select “None” for 
the system standby setting or the set-
ting of the time before entering the sleep 
mode of Windows running on the com-
puter. Note that data sent from the com-
puter is discarded when the computer is 
recovered from the standby mode.

To configure the system standby setting 
or sleep mode setting in Windows, 
select Control Panel from the Start 
menu. Then select Power Options.

Check Point Solution

Check whether non QuickLabel media 
is used.

Use only QuickLabel media for the 
printer. Otherwise, a media jam or fail-
ure may result.

The edge of the paper is folded or 
curled.

If the leading edge of the paper is folded 
or curled, it will not feed correctly. This 
could also cause a media jam.

Check whether the label is likely to 
come off due to deteriorated adhesive.

Never use media having labels which 
are likely to come off. Printer failures 
can result.

Check whether the paper guide is set in 
accordance with the media width.

Set the transport guide in accordance 
with the paper width, and then set the 
paper guide such that it clicks.

Check Point Solution
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Status Monitor Does Not Start

Print Results are Unsatisfactory

Random Characters are Printed

Check Point Solution

The Status Monitor setting is incorrect. With some Status Monitor settings, 
printer errors will not be displayed and 
the Status Monitor will not start. Open 
the printer driver Status tab and then 
click Launch Monitor. Set the details 
after the Status Monitor starts.

Check whether the printer and computer 
can communicate interactively.

If the printer and computer cannot com-
municate interactively, the Status Moni-
tor does not start even if printing starts.

Open the Properties of the printer driver, 
and then click the Port tab. Check that 
the Enable Bidirectional Support check-
box is checked.

If the problem persists after taking the 
above action, uninstall the printer driver, 
and then reinstall the printer driver.

Check Point Solution

An interface cable is disconnected. Check the interface cable and make 
sure that it is connected to the printer 
and the computer.

The printer driver is not selected on the 
computer.

Make sure that the Kiaro! printer is 
selected when you start the print job.

Check whether a test pattern is printed.

Note that 4” x 5” label stock is required.

Try printing a test pattern from the Test 
Print tab in the Maintenance Utility.

If the test pattern is printed, check the 
application software settings, operation 
method, and print data content.

If the test pattern is not printed, contact 
QuickLabel Support.
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Slow to Print

Print Quality is Poor

Check Point Solution

Check whether the number of copies is 
specified on the application side.

If the number of copies is specified on 
the application side, new print data is 
sent each time printing of a copy is com-
pleted, requiring a long time to finish 
printing the specified number of copies. 
In such a case, specify the number of 
copies on the printer driver side.

Print speed is set to a lower speed. Set the print speed in the Layout tab of 
the printer driver or in Custom QuickLa-
bel Omni. Auto print speed is recom-
mended.

Check Point Solution

White spots due to missing colors. Open the Cleaning tab of the Mainte-
nance Utility and perform cleaning.

If the problem persists after performing 
cleaning, contact QuickLabel Support.

Printout is faint. Open the Cleaning tab of the Mainte-
nance Utility and perform cleaning.

If the problem persists after performing 
cleaning, contact QuickLabel Support.

Misalignment of colors appears. Open the Adjustment tab of the printer 
and perform registration.

The overall print quality is poor. Use only QuickLabel media for the 
printer. Otherwise, a media jam or fail-
ure may result.
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Printed Colors Appear Incorrect

Printing in One Color

Check Point Solution

Wrong colors are printed. Check the image in your design applica-
tion. If necessary, make adjustments in 
the Advanced Color Settings window.

Open the Control Panel of your com-
puter, and then check whether the set-
tings in the Display Properties and 
Screen Properties are correct.

When the setting for the display type or 
gamma coefficients is wrong, correct 
colors are not displayed on the display.

The overall print quality is poor. Use only QuickLabel media for the 
printer. Otherwise, a media jam or fail-
ure may result.

Image is too bright or too dark. Check the image in your design applica-
tion. If necessary, make adjustments in 
the Advanced Color Settings window.

The image contrast is too strong or 
weak.

Check the image in your design applica-
tion. If necessary, make adjustments in 
the Advanced Color Settings window.

Image is faint. Check the image in your design applica-
tion. If necessary, make adjustments in 
the Advanced Color Settings window.

Check Point Solution

The software application is set up for 
single color printing.

Some software applications may allow 
you to print in one color. Check the print 
settings in the software application on 
the computer.
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Print Samples and Solutions

Spur Gear Mark

Description
Spur gears are located in several locations throughout the transport assembly. They 
help keep the media flat to avoid jamming during printing and ensure the media 
receives the ink correctly.

Causes
As media passes through the transport assembly, these gears come into contact with 
the surface of the label material.

Possible Solutions
Clean the spur gears with a slightly damp lint-free cloth and let air-dry before use.
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Background Pattern

Description
Often called “Keep Alive Dots”, this ink is sprayed in the background to prevent nozzles 
from clogging when not in constant use.

Cause
As media passes through the transport assembly, nozzles that are not firing based on 
the position and the label content being printed will fire the smallest amount of ink 
possible based on a built-in algorithm.

Possible Solutions
A solution is not applicable because the pattern is normal.
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Printhead Not in Correct Position

Description
Printed output does not resemble specified label content, but rather abstract patterns 
of ink with varying ink dispersion.

Cause
The print module is obstructed and did not fully lower into a printing position. The 
distance between the media and the printheads will produce abstract printed output.

Possible Solutions
Contact Technical Support.
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Media Contacting Printheads

Description
Streaks of CMYK appear down-web, bleeding at various points, indicating a smearing.

Cause
Media is physically coming into contact with the printhead surfaces as it passes through 
the transport assembly.

Possible Solutions
Reload the media, ensuring it is perfectly centered and the media guides are not 
causing wrinkling.

Inspect the roll of media for defects.
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Poor Print Quality

Description
Severe mottled look across the printable web. Ink unable to be absorbed further. Ink 
may exhibit signs of cracking across the top of the media.

Cause
Using unapproved media type or using wrong media profile.

Possible Solutions
Use approved media or the correct media profile.
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Media Surface Contamination

Description
Fingerprints or other marks related to handling the media before printing are visible 
after the label has been printed.

Cause
Contaminants on the label surface can cause undesirable defects or anomalies 
because it interferes with the absorption of ink into the media.

Possible Solutions
Handle the media with care.
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Scuffing of Surface Material

Description
Light reflecting off the surface of the printed labels highlights the various scuff marks, 
scratches, dull and/or mottled area of the label material.

Cause
Inherent flaws in the surface of a media can become more visible after printing solid 
color fills.

Possible Solutions
Try using a rewinder with a dancer-arm, as this helps ensure the media is as flat and 
moves as smoothly as possible.
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Non-Functioning Nozzle

Description
A very thin vertical line in the printed output appears in the print direction, but is only 
lighter overall than it is supposed to be, not completely absent of color.

Cause
A nozzle is no longer functioning in the printhead. This is fundamentally different from 
a nozzle that could work but doesn’t. This typically will only occur in printheads being 
used beyond their life expectancy.

Possible Solutions
Running a printhead cleaning routine from the maintenance utility will attempt to 
resolve the clog, if that is possibly the cause. Cleaning Printheads

Running a missing nozzle adjustment routine in the maintenance utility and adjusting 
based on which number has broken lines around it will help compensate by firing the 
adjacent nozzles more. Using the Missing Nozzle Adjustment
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Clogged Nozzle

Description
A thin vertical line appears in the print direction as a complete absence of color.

Cause
A nozzle in the printhead is clogged by debris, dried ink, or an air bubble.

Possible Solutions
Running a printhead cleaning routine from the maintenance utility will attempt to 
resolve the clog. Cleaning Printheads

Running a printhead priming routine from the maintenance utility will drain and refill the 
printheads with ink. Priming the Printheads

If the problem persists, please contact Technical Support.
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Debris on Printhead

Description
A thicker vertical line appears through the printed output in the print direction as a 
complete absence of color.

Cause
Multiple contiguous nozzles in the printhead are clogged by debris.

Possible Solutions
Running a heavy printhead cleaning routine from the maintenance utility will attempt to 
resolve the clog. Cleaning Printheads

Running a printhead priming routine from the maintenance utility will drain and refill the 
printheads with ink. Priming the Printheads

If the problem persists, please contact Technical Support.
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Wide Voids in Print

Description
Wide areas across one or more printheads are not printing.

Cause
The printheads are not correctly seated in the print module and data is being lost as a 
result.

Possible Solutions
Please contact Technical Support.
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Changes in Density Due to Torque

Description
Horizontal lines of density change across the web.

Cause
Too much torque is causing the label roll to get pulled during printing.

Possible Solutions
Lower rewinder torque.

Move the rewinder closer/further from the label exit.

Ensure the rewinder is at the proper elevation.

Ensure the rewinder is properly centered to the media.
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Physical Smearing of Wet Ink

Description
Smear marks on media surface after printing.

Cause
Media is physically coming into contact with surfaces before ink is dried.

Possible Solutions
Handle media with care post-printing.

Ensure media is loaded correctly and is flat while passing through the transport 
assembly.
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Media Being Pulled at Label Exit

Description
Overlapping label content/shifting label content.

Cause
As the ink is being sprayed in the printer, the media moves faster or slower than 
intended and a print defect results.

Possible Solutions
If a rewinder is in use, ensure the rewinder is perfectly centered with the exiting media.

Ensure the label exit is uninhibited.

Lower rewinder torque.
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Printhead Contamination

Description
Color-smearing occurring even in pure CMYK printed output after performing a 
physical cleaning.

Cause
Introduction of ink from one printhead into a different printhead with use of a cleaning 
stick has contaminated the printhead in question.

Possible Solutions
Perform a printhead priming and then immediately one or more heavy cleanings via the 
maintenance utility to flush the ink out.

• Priming the Printheads

• Cleaning Printheads
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Manually Uninstalling the Printer Driver
You can use the installer wizard to uninstall the printer driver. However, in some 
situations, the wizard may not remove all driver components. As an alternative, use the 
following instructions to uninstall the printer driver manually.

Note: This procedure requires administrator level access in Windows.

1 If the printer is connected to the PC with a USB cable, unplug the USB cable from 
the PC.

2 Open the appropriate printer window based on your version of Windows.

• In Windows XP, choose Start > Printers and Faxes.

• In Windows Vista, choose Start > Control Panel > Printers.

• In Windows 7, choose Start > Devices and Printers.

• In Windows 8, access the Search option by pointing to the upper-right corner 
of the screen. Search for "Control Panel" and click the Control Panel icon. In 
the Control Panel window, click View Devices and Printers.

3 Right-click the Kiaro! printer model you want to remove, then select Remove 
Device. Repeat this step for all Kiaro! printer models that use the driver.

4 Select any remaining printer. The Print server properties option will appear in the 
toolbar. Choose the Print server properties option. The Print Server Properties 
window will open.

Note: If you are using Windows XP, choose Server Properties from the File 
menu.
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Select the Drivers tab in the Print Server Properties window.

5 Choose Change Driver Settings. The drivers will become available for removal.

Note: This step is not required for Windows XP.
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6 Select a Kiaro! driver. Then choose Remove. You will be prompted to select the 
removal method.

Select Remove driver and driver package. Then choose OK.

A confirmation message will appear. Choose Yes to continue. The Remove Driver 
Package window will open.

7 Choose Delete.

8 Delete all other Kiaro! drivers displayed in the Drivers tab.

9 Restart the PC.
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7 RW-5 Rewinder

Before Installing the Rewinder
Before installing the rewinder, observe the following precautions.

• No rewinder feet should float. The rewinder must be held level constantly.

• The rewinder must be installed on the same plane as the printer.

• When placing the rewinder on a desk, table, or other similar surface, it must be 
sturdy and stable enough to support the weight of the printer and the rewinder.

• Do not turn the rewinder mandrel by hand to rewind the media. Turning the mandrel 
by hand can result in rewinder damage.

Installing the Rewinder
1 Ensure the power switch on the rewinder is in the off position.

2 Arrange the rewinder and brackets as illustrated below. Refer to this illustration 
through the installation process.

R

R-U

U

RW-5
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3 Insert the tabs from bracket U into the slots on bracket R. These two brackets will 
later be used to position the Kiaro! printer.

4 Fasten the R-U bracket to the R bracket using the supplied thumb nuts. Ensure the 
threaded pin is centered in the adjustment slot.

Note: These thumb nuts may need to be loosened at a later time when aligning 
labels during rewinding.

5 Fasten the RW-5 rewinder to the R-U bracket using the supplied thumb screws.

Note: These thumb screws may need to be loosened at a later time when aligning 
labels during rewinding.

6 Use the Moving feature in the Kiaro! Maintenance Utility. This utility will prepare the 
printer for lifting and moving onto the brackets. Preparing for Moving

7 Holding the handles at the bottom of the printer, lift the printer and then place it on 
the connected R and U brackets. Lift from the illustrated points. Do not hold the 
front side of the printer. Ensure the printer remains level as you move it.
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Note: The printer weighs about 53 pounds (24 kilograms). Two persons are 
required to lift the printer. Two persons standing at the front and back of the printer 
respectively must lift the printer by holding it with their hands under the bottom 
handles (two at the front, one at the left, and one at the right). Attempting to lift the 
printer in an improper position can result in the printer falling or injury.

Ensure the printer sits level on the alignment brackets as illustrated below.

8 Plug the power jack into the power slot on the rewinder. Insert the power plug into 
an AC power receptacle.
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Rewinding Labels
The rewinder automatically winds printed media exiting the Kiaro! onto rolls. The setup 
process for rewinding labels requires an empty label core and tape.

Note: Do not turn the rewinder mandrel by hand to rewind the media. Turning the 
mandrel by hand can result in rewinder damage.

1 Ensure the power switch [3] on the rewinder is in the off position.

2 Turn the rewinder mandrel adjustment knob [4] counterclockwise to loosen the 
mandrel.

3 Remove the outer flange [2] from the mandrel.

4 Load an empty label core on the mandrel.

Use an empty label core of the same width as the label media you will be using. 
Install the roll core on the rewinder, sliding it until it contacts the inner flange [1]. 
The outer flange [2] will be installed after you fasten the label media to the roll core.

5 Start a print job. Pause the job when the printed media advances slightly past the 
rewinder.

[3]

[1]

[4] [5]

[2]
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6 Feed the media under the rewinder dancer arm [5] and up around the empty label 
core. The inside edge of the media should be aligned squarely with the inner flange 
[1].

If the media is not squarely aligned with the inner flange, adjust the position of the 
rewinder as needed.

• Loosen the thumb screws that fasten the RW-5 rewinder to the R-U bracket. 
Slide the rewinder left/right as allowed by the adjustment slots until the media 
is squarely aligned with the inner flange. Then tighten the thumb screws.

• If a greater adjustment range is needed, loosen the thumb nuts that fasten the 
R-U bracket to the R bracket. Slide the rewinder left/right as allowed by the 
adjustment slots until the media is squarely aligned with the inner flange. Then 
tighten the thumb nuts.

7 Fasten the end of the media to the core with tape. Ensure the printed side faces 
out.

8 Adjust the spring collar on the dancer arm. Slide the collar just before it contacts 
the media. Label media should be able to move smoothly without being hindered 
by the collar.

9 Reinstall the outer flange [2] and then turn the mandrel adjustment knob [4] 
clockwise to tighten the mandrel.

10 Turn the power switch [3] on the rewinder to the on position.

When the dancer arm is in a lowered position, the rewinder mandrel will rewind 
media as needed. Do not turn the mandrel by hand to rewind the media. The media 
rewind path is illustrated below.

11 Resume the print job on the Kiaro! printer. The rewinder will rewind media 
automatically as needed. The rewinder will stop when the printer stops advancing 
media or when the printer is out of media.
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8 UW-5 Unwinder

Before Installing the Unwinder
Before installing the unwinder, observe the following precautions.

• No unwinder feet should float. The unwinder must be held level constantly.

• The unwinder must be installed on the same plane as the printer.

• When placing the unwinder on a desk, table, or other similar surface, it must be 
sturdy and stable enough to support the weight of the printer and the unwinder.

• Do not turn the unwinder mandrel by hand to unwind the media. Turning the 
mandrel by hand can result in unwinder damage.

Installing the Unwinder
1 Ensure the power switch on the unwinder is in the off position.

2 Arrange the unwinder and brackets as illustrated below. Refer to this illustration 
through the installation process.

3 Insert the tabs from bracket U into the slots on bracket R. These two brackets will 
later be used to position the Kiaro! printer.

4 Fasten the R-U bracket to the U bracket using the supplied thumb nuts. Ensure the 
threaded pin is centered in the adjustment slot.

R

R-U

U

UW-5
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Note: These thumb nuts may need to be loosened at a later time when aligning 
labels during unwinding.

5 Fasten the UW-5 unwinder to the R-U bracket using the supplied thumb screws.

Note: These thumb screws may need to be loosened at a later time when aligning 
labels during unwinding.

6 Use the Moving feature in the Kiaro! Maintenance Utility. This utility will prepare the 
printer for lifting and moving onto the brackets. Preparing for Moving

7 Holding the handles at the bottom of the printer, lift the printer and then place it on 
the connected R and U brackets. Lift from the illustrated points. Do not hold the 
front side of the printer. Ensure the printer remains level as you move it.

Note: The printer weighs about 53 pounds (24 kilograms). Two persons are 
required to lift the printer. Two persons standing at the front and back of the printer 
respectively must lift the printer by holding it with their hands under the bottom 
handles (two at the front, one at the left, and one at the right). Attempting to lift the 
printer in an improper position can result in the printer falling or injury.

Ensure the printer sits level on the alignment brackets as illustrated below.

8 Plug the power jack into the power slot on the unwinder. Insert the power plug into 
an AC power receptacle.
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Unwinding Labels
The unwinder automatically unwinds media into the Kiaro! for printing. This allows for 
larger diameter rolls to be used as an alternative to the standard roll holder.

Note: Do not turn the unwinder mandrel by hand to unwind the media. Turning the 
mandrel by hand can result in unwinder damage.

1 Ensure the power switch [3] on the unwinder is in the off position.

2 Turn the unwinder mandrel adjustment knob [4] counterclockwise to loosen the 
mandrel.

3 Remove the outer flange [2] from the mandrel.

4 Orient a roll of label media and seat it on the mandrel. The media should unwind 
over the top of the roll toward the printer. Ensure the side of the roll contacts the 
inner flange [1].

5 Reinstall the outer flange [2] and then turn the mandrel adjustment knob [4] 
clockwise to tighten the mandrel.

[3]

[1]

[4]

[5]

[2]
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6 Open the roll cover.

7 Remove the roll holder from the printer. The roll holder is unnecessary when using 
the unwinder.

8 Push the lever of the paper guide to open the guide.
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9 Open the transport guide (right), and slide it rightward until it stops.

10 If you are using gap or reflective mark media, cut the media edge that will be fed 
into the printer. If you are using continuous media, skip this step.

• If you are using gap media, cut the media between labels as illustrated by the 
dashed red line below. The arrow indicates the direction of media feed into the 
printer.
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• If you are using reflective mark media, cut the media between labels, but 
before the mark, as illustrated by the dashed red line below. The arrow 
indicates the direction of media feed into the printer.

11 Turn the power switch [3] on the unwinder to the on position.

12 Feed the media under the dancer arm and up into the entry slot on the rear of the 
printer. The media path is illustrated below.

As the dancer arm is lifted, the mandrel will unwind and feed media as needed. Do 
not turn the unwinder mandrel by hand to advance the media. If you need to 
advance the media, lift the dancer arm slightly.
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13 Insert media along the left-side guide under the transport guide (left) until it stops 
at the roller in the feeder slot.

Media at the roller in the feeder slot is automatically pulled in slightly.

14 If the media is not squarely aligned in the feeder slot, adjust the position of the 
unwinder as needed.

• Loosen the thumb screws that fasten the UW-5 unwinder to the R-U bracket. 
Slide the unwinder left/right as allowed by the adjustment slots until the media 
is squarely aligned in the feeder slot. Then tighten the thumb screws.

• If a greater adjustment range is needed, loosen the thumb nuts that fasten the 
R-U bracket to the U bracket. Slide the unwinder left/right as allowed by the 
adjustment slots until the media is squarely aligned in the feeder slot. Then 
tighten the thumb nuts.

15 Slide the transport guide (right) in accordance with the width of the media.

Note: Do not press the transport guide (right) strongly against the media edge. A 
paper jam can result.
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16 Slowly close the transport guide (right) to lock it.

17 Slowly push the paper guide down until it clicks (locks). When it locks, media is 
transported automatically.

18 Close the roll cover.
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9 Safety Warnings and Precautions

Before using this printer, please read this section thoroughly. Warnings to heed and 
important matters are described here to prevent damage to the user and other persons.

Do not attempt to operate this printer in any way other than those mentioned in the User 
Guide.

Location
Make sure there is sufficient space around the printer.

Warning

• Never place items on the printer such as a flower vase, potted plant, cosmetics, 
any liquid filled container, or metal fasteners. If such items were to fall on the 
printer, this could cause a fire, electrical shock, or damage to the printer.

• The electrical contacts inside the printer become extremely hot during normal 
operation. To avoid causing a fire, never store flammable substances like alcohol, 
thinner, etc. near the printer.

Caution

Avoid using the printer in the following types of locations.

• Where the printer is exposed to open air or high humidity. This could cause a fire, 
serious electrical shock, or damage to the printer. Also, if the printer is carried into 
a warm room on a cold day, this could cause condensation inside the printer. If this 
happens, allow the printer to sit for at least 1 hour at room temperature to adapt to 
the ambient temperature and humidity.

• Never place the printer on a slanted or unstable stand or table. If the printer is 
dropped or slides off, this could cause personal injury. Also, never place a heavy 
object on top of the printer. If the object is dropped or falls, this could cause injury.

• Never expose the printer to open air or dust. This could cause a fire, serious 
electrical shock, or damage to the printer. Also, never locate the printer near a 
water faucet or in any other location where it will be exposed to water. This could 
cause serious electrical shock.

• Never set up the printer in a location that is exposed to high humidity or large 
amounts of dust, or exposed to direct sunlight, high temperature, or open flame. 
This could cause a fire or electrical shock.

• Use the printer in an environment where temperature and humidity are within the 
ranges of 59°F to 86°F (15°C to 30°C) and 10 to 80% RH (with no condensation).

• To ensure normal operation of the printer and avoid possible damage, never install 
the printer near large office equipment or any other type of electrical device that 
emits a strong magnetic field.
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• Never block the ventilation ports on the printer. A blocked ventilation port could 
cause heat to build up inside the printer and cause a fire. Also, place the printer in 
an area where you can disconnect the power cord immediately; keep the area 
around the power cord connection free of obstacles. This allows you to unplug the 
power cord quickly in an emergency.

Power Supply and Power Cord
Warning

• To avoid causing a fire or serious electrical shock, always use the power cord 
provided with this printer. To avoid a fire or electrical shock, do not use an 
extension cord.

• To avoid a fire or serious electrical shock, connect the printer power cord to an 
independent power source that is not shared by other equipment or appliances.

• To avoid causing a fire or serious electrical shock, make sure that the power plug 
is securely and completely inserted into the power source.

• Do not cut, damage, or otherwise alter the power cord. To avoid the dangers of fire 
and electrical shock, never place a heavy object on the power cord, never expose 
it to heat, and never pull on the cord to disconnect it. If the power cord is damaged 
in any way (condensation on exposed wires, broken wires, etc.) contact the dealer 
where you purchased the printer or the nearest service center for a replacement.

• To avoid personal injury from an electrical shock, never handle the power cord or 
plug when your hands are wet.

• To avoid a fire or serious electrical shock, never knot the power cord or wrap it 
around itself.

• Disconnect the printer power cord during severe electrical storms. Lightning could 
cause a fire or severe electrical shock or damage to the printer.

• To avoid a fire hazard, occasionally disconnect the power cord from the printer and 
the power supply and use a soft dry cloth to clean the cord connectors and the 
connection points. Leaving the cord plugged in and not cleaned for a long period, 
especially in an area subject to dust, oil, and high humidity, could cause the 
insulation material to deteriorate.

Caution

• Be sure to turn off the printer before removing the power plug from the outlet.

• Check the power plug and cord for any problem (abnormal heat, rust, bend, cracks, 
scratches, etc.) at least once a month.

• If any problem with the power plug or cord is found, replace it. Using it without 
replacement can result in a fire or electrical shock hazard.

• To avoid damaging the power plug, which could cause a short circuit and cause a 
fire or electrical shock, never pull on the power cord to unplug the cord from the 
power supply. Always grip the plug to remove it from the power supply.
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• If the printer will not be used for a long period, for your safety disconnect the power 
cord from the power source.

• Always keep the area around the power plug free of obstacles so you can unplug 
it easily. This allows you to unplug the power cord quickly in an emergency.

• Never use any power source other than the one rated for the printer. This printer is 
designed to be used in the region where purchased. Also, make sure the power 
source can supply sufficient power for the printer. This could cause a fire or serious 
electrical shock, or damage the printer.

Supply voltage: AC 220 - 240 V or AC 100 - 120 V, 50/60 Hz

Power consumption: 440W (max), sleep mode 10W

General Safety
Warning

• If you find a large ink leak, switch the printer off immediately, disconnect the power 
plug from the power source, and call for service. If you continue to use the printer, 
this could cause a fire or serious electrical shock.

• Never clean the printer with water or any flammable liquid (alcohol, benzene, 
thinner, etc.) either applied directly or with a cloth. If you accidentally spill liquid on 
the printer, switch the printer off immediately, disconnect the power plug from the 
power source, and call for service. If you continue to use the printer, this could 
cause a fire or serious electrical shock.

• If the printer emits smoke, unusual odors, or makes noises, leaving it could cause 
a fire or serious electrical shock or damage to the printer. Switch the printer off 
immediately, disconnect the power plug from the power source, make sure that the 
printer has stopped smoking, and call for service. Do not attempt to repair the 
printer by yourself. This could cause a fire or serious electrical shock.

• Use only a slightly damp cloth, thoroughly wrung out, to clean the printer surfaces. 
Never use alcohol, thinner or any other flammable liquids. If such materials come 
into contact with electrical components inside the printer, this could cause a fire or 
serious electrical shock.

Caution

• There are high voltage points inside the printer. To avoid a fire or electrical shock, 
never attempt to disassemble or repair the printer.

• Never insert or drop any metal objects into the printer when it is open. This could 
cause a fire or serious electrical shock, or damage the printer. If something falls 
into the printer accidentally, switch the printer off immediately, disconnect the 
power plug from the power source, and call for service. If you continue to use the 
printer, this could cause a fire or serious electrical shock.

• If the printer is dropped and damaged, switch the printer off immediately, 
disconnect the power plug from the power source, and call for service. If you 
continue to use the printer, this could cause a fire or serious electrical shock.

• To avoid a fire or electrical shock, never use flammable sprays around the printer.
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• Never remove the cover from the printer. This could cause a serious electrical 
shock.

• It is dangerous to put your fingers deep inside the ink cartridge boxes. There are 
pin-sharp parts which may hurt you or alternatively you may cause damage that will 
lead to breakdown.

• Keep children from touching the power cord, internal parts of the printer when it is 
open, and moving parts inside the printer (gears, belts, rollers, and electrical 
components). This could cause personal injury or damage the printer.

• Labels printed with this printer should not directly be stuck on food such as fruits 
and vegetables. They should be stuck on the plastic wrap over the food.

Important

• To prevent machine failures, do not open the ink tank door or maintenance 
cartridge exchange door, do not turn off the printer, and do not remove the power 
plug from the outlet while the printer is printing. If you do so, the print head 
protection function is not performed properly, resulting in a machine failure or ink 
leakage which can soil your clothes and the surrounding area.

• Do not apply excessive force or strong shock to the upper unit. Doing so can result 
in a machine failure or impair printer quality. Be sure to open/close the upper unit 
slowly.

• Do not place the printer close to TV, radio receiver or loudspeakers, etc. The 
magnetic field produced may cause the printer to malfunction, or the printer may 
interfere with TV/radio reception.

• Printed labels and ink can discolor due to ultraviolet rays and ozone.

Moving the Printer
Warning

• Call the dealer for advice before you ship the printer a long distance or move the 
printer by car or truck where it may be subjected to shock and vibration. Moving the 
printer without the proper preparation could subject it to shocks and vibrations 
which could damage the printer and cause a fire.

Caution

• Before moving the printer, use the appropriate procedures to drain ink from the 
printhead or entire print system. See Preparing for Moving and Preparing for 
Shipping.

• Before you move the printer to another location in the same building, disconnect 
the power cord and make sure that all other cables are disconnected.

• The printer weighs about 53 pounds (24 kilograms). Two persons are required to 
lift the printer. Two persons standing at the front and back of the printer respectively 
must lift the printer by holding it with their hands under the bottom handles (two at 
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the front, one at the left, and one at the right). Attempting to lift the printer in an 
improper position can result in the printer falling or injury.

• Always hold the printer level and carry it slowly. If ink is spilled inside the printer 
while moving it, this could cause a fire or serious electrical shock or damage the 
printer.

Important

• To prevent machine failures, do not relocate or transport this printer with the upper 
unit open.

Ink Tank and the Maintenance Cartridge
Caution

• Always store these items out of the reach of small children. This prevents 
accidents. If a child accidentally swallows ink, seek medical attention immediately.

• If ink gets into your eyes, wash it out with flowing water immediately. If irritation 
persists, consult a physician.

• If ink comes into contact with your skin, rinse it off with flowing water immediately. 
If irritation persists, consult a physician.

• Never drop or apply excessive force to an ink tank or the maintenance cartridge. 
Ink can stain clothing and the work area.

• Never attempt to disassemble or modify the ink tanks. They contain ink, which may 
leak out and smear your clothes or things around you.

Important

• Do not install or remove the ink tank or maintenance cartridge unless it needs to 
be replaced. Doing so can accelerate wear of the printer components.
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10 Specifications

Printer

Printing method Inkjet

Print colors Full color

Output resolution 1200 x 1200 dpi

Printing speed (Kiaro!) 200/160/120/100/90/80/70/60/50 mm/s

Auto

Printing speed (Kiaro! D) 150/120/100/90/80/70/60/50 mm/s

Auto

Printable area 106.3mm(W) × 397mm(L)

Print margin (relative to media transport 
direction)

Top and Bottom 1.5 mm

Left/Right 2.5 mm

When using label media, it must have 
left and right margins, each of which is 
1.5mm or wider in relation to the left and 
right media edges respectively.

Printhead 5,124 nozzles (number of effective noz-
zles)

Paper Matte coated paper, glossy paper

Paper size 25.4 mm - 120 mm (W), 6 mm - 400 mm 
(L)

Paper thickness 145 ~ 255 µm

Paper capacity Max 200 mm / Paper core 76.2 mm

Ink used Aqueous dye-based ink

Yellow (Y), Magenta (M), Cyan (C), and 
Black (Bk)

Interface Hi-Speed USB, 
1000BASE-T/100BASE-TX/10BASE-T

Extension interface RS-232C X 2
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Operating noise About 70 dB or less

Installation environment (temperature) 59 to 86 degrees Fahrenheit

15 to 30 degrees Celsius

Installation environment (humidity) 10% to 80% relative humidity (no con-
densation)

Power supply AC100-240V 50/60Hz

Power consumption Maximum power: 440W or less

Sleep mode: 10W or less

Dimensions 15.2 in (W) x 22.4 in (D) X 15.5 in (H)

386 mm (W) X 570 mm (D) X 394 mm 
(H)

Weight 57.3 lbs with supplies

26 kg with supplies

RW-5 Rewinder & UW-5 Unwinder

Maximum Rewind Diameter 11.81" (30cm)

Minimum Label Width 1.0" (25mm)

Maximum Label Width 4.72" (120mm)

Core Size 3" ID (76mm)

Rewind Direction Fixed

Torque Self-regulating for Kiaro!

Power Universal, 100 - 240V, 1.8A, 50-60Hz

Accessories Includes adjustable printer and winder 
alignment plates

Dimensions 15.8" (402mm) H x 12.6" (320mm) W x 
11.9" (302mm) D

Weight 16 lbs. (7 kg)

Shipping Weight 21 lbs. (14 kg)

Printer
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